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Introduction to FREDS 2000 

FREDS 2000--Overview 

The Florida Redistricting System (FREDS 2000) is a tool for building and 
analyzing Florida Congressional, Senate and House districts. It was 
commissioned by the President of the Senate and the Speaker of the House of 
Representatives and developed by staff of the Office of Economic and 
Demographic Research, the Florida Senate, the Florida House of 
Representatives, and the Office of Legislative Information Technology Services. 

The overriding design objective is to give decision makers direct and easy 
access to the vast amount of demographic information pertinent to redistricting. 
This is accomplished with a set of tools that operate on a map interface, including 
tools for navigating the map (zoom/unzoom, pan, add/delete themes), for 
constructing districts, and for exploring the population characteristics of counties, 
tracts, blocks, municipalities and the voting characteristics of precincts. The 
application also keeps track of the population and voting characteristics of 
districts as they are being built. 

The target user group includes legislators and others who are not GIS 
(geographical information system) experts. The functionality of the application is 
limited to what is needed for building districts and accessing the associated data. 
The application has a simple facility for printing map views. Custom map 
products can be produced using separate GIS software in tandem with data from 
the application. 

The application includes more than 2 GB of census and election data for the 
State of Florida. These data were assembled from information supplied by the 
U.S. Bureau of the Census (population counts and TIGER/Line files), the 67 
supervisors of elections in Florida (precinct level election results), and the 
Department of State (central voter file). 

Reapportionment and Redistricting Basic Facts 

Demographic Information 

The population of Florida as of April 1, 2000, according to the Bureau of Census, 
United States Department of Commerce:   15,982,378 (ranked 4th in US) 
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Average District Populations 

  1980 1990 2000 

Congress 19 districts 512,998 23 districts 562,519 25 districts 639,295 

Senate 40 districts 243,674 40 districts 323,448 40 districts 399,559 

House 120 districts 81,225 120 districts 107,816 120 districts 133,186 

Total State   9,746,959   12,937,926   15,982,378 

  

Significant Dates 

Regular Session January 22-March 22, 2002 

Federal Qualifying July 6-12, 2002 

State Qualifying July 15-19, 2002 

General Election November 5, 2002 

  

System Requirements for FREDS 2000 

FREDS 2000 is designed for Microsoft Windows 98 or higher operating systems. 
Windows NT version 4.0 is not supported. FREDS 2000 requires a personal 
computer equipped with a Pentium III or better processor running at 300 MHz or 
faster. The minimum memory requirement is 64 MB of RAM. Performance 
improves significantly in systems with a 500 MHz or faster processor and 128 MB 
or more of RAM. 

To improve system performance, close all unnecessary applications prior to 
opening FREDS 2000. FREDS 2000 requires a large amount of system 
resources and may interfere with the ability to open other applications.  

Installing FREDS 2000 

Place the FREDS 2000 CD into the CD ROM drive. When the computer reads 
the CD, the installation program should launch automatically. If the installation 
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program does not start up on its own, open Windows Explorer and double-click 
the icon for Autorun.inf located in the CD ROM drive. 

The default destination folder for FREDS 2000 is C:\Program Files\Freds 2000. If 
the C: drive does not have adequate free space (approximately 3 Gigabytes) to 
accommodate the installation, you may wish to select another destination. Follow 
the instructions in the setup program to finish the installation. The installation 
process may require rebooting the computer one or more times. 

The FREDS 2000 installation program puts a shortcut icon on the desktop and a 
shortcut icon in the Programs section of the Start Menu. Double-clicking either 
icon will launch FREDS 2000. 

The installation program also creates a directory, C:\Data\Freds 2000, where 
plans are stored. The existing plans of record; the 1996 Senate Plan, the 1992 
House Plan, and 1996 Congressional plan, are in this directory. Any plan created 
by the user will be stored in this directory by default. This is also the default 
location where FREDS 2000 looks for existing plans. 

License 

The purchaser of the FREDS 2000 software is granted a single use license. 
"Single use license" means a license must be dedicated for each computer or 
network access point that has use rights for the Software, Data, or 
Documentation. Licensee may make a second copy for Licensee's exclusive use 
on a portable computer so long as only one (1) copy of the Software, Data, and 
Documentation is in use at any one (1) time. Portions of this application are the 
intellectual property of ESRI and are used herein under licenses. Copyright © 
2001 ESRI. All rights reserved. ESRI and MapObjects are registered trademarks 
of ESRI in the United States and certain other countries; registration is pending in 
the European Community. The MapObjects logo is a trademark of ESRI. 
Copyright © 2001 State of Florida. 

  

Notice of Software Disclaimer and Use  

The FREDS 2000 software IS PROVIDED "AS IS" and bears NO WARRANTY, 
EITHER EXPRESS OR IMPLIED of a FITNESS FOR A PARTICULAR 
PURPOSE. The Florida Legislature and the State of Florida do not assume 
liability or responsibility for any user's use of FREDS 2000 software or the results 
of such use. 
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Getting Started with FREDS 2000 

Getting Started 

This tutorial will familiarize you with many of the common functions you will use in 
FREDS 2000. 

Lesson 1: Copying a Plan 
Lesson 2: The Plan Interface 
Lesson 3: Navigating on the Map 
Lesson 4: Customizing the Map 
Lesson 5: Starting a New Plan 
Lesson 6: Using the Statistics 
Lesson 7: Using Multiple Plans 
Where to Go From Here 
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Lesson 1: Copying a Plan 

Start with an existing plan so we can look at some of the important features.  
• Choose Open from the File menu.  

• From the Open dialog, select c412.pln. This is the congressional plan in effect prior 
to redistricting in 2002. 

• Select Save As from the File menu and name the new plan MyPlan.  

• Now the current plan is a copy of c412 named MyPlan; the original plan c412 then 
will not be affected by changes made during the session. 

Related Topics:    
   
Creating a New Plan 
Opening an existing Plan 
Importing a Plan 
Saving a Plan 

 
Lesson 2: The Plan Interface 

Take a few minutes to look at the features in the Plan Interface. The largest 
feature is the Map. Under it is the Statistics Grid; to the left of that is the 
Locator Map; above which is the Theme Manager and above that is the District 
Palette. Along the top of the Plan Interface window is the Title Bar. The title bar 
contains the name of the plan, the type of plan (Congress, in this case) and the 
Active District. Along the bottom of the plan interface is the Status Bar, which 
contains the View Buttons, District and County Locking checkboxes, the 
Message Center and the map's Scale. Whenever you perform an important 
function in FREDS 2000, the Message Center will show a message confirming 
what action was taken. 

Related Topics: 

View of the Plan Interface 
Map 
Statistics Grid 
Locator Map 
Theme Manager 
District Palette 
Title Bar 
Status Bar 
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Lesson 3: Navigating on the Map 

The Map shows the entire State of Florida, but most of the time you will want to 
look at only a small part of the state. FREDS 2000 offers several ways to 
navigate on the map. 

• Click the Zoom In (magnifying glass with a plus icon) button on the Toolbar, then click 
and drag on the map to draw a rectangle on the area where you want to zoom. 

• Click the Zoom Out (magnifying glass with a minus icon) button on the Toolbar, then 
click on the map to zoom out. 

• Click the Pan (hand icon) button on the Toolbar, then click and drag on the map to 
pan the view to adjacent geography. 

• Click and drag the scroll bars on the right and bottom edges of the map. 

• Click the down arrow on the Extent Drop Down Box (on the Toolbar where you see 
the words "State of Florida"). Select a place to zoom into from this list. 

• Click and drag a rectangle on the Locator Map in the lower left corner of the Plan 
Interface. The Map will zoom to the area you outline. 

• Hold the Shift button and right-click on a district number in the District Palette. The 
Map will zoom to the district you selected in the District Palette. 

• Right-click and drag with your mouse on the map to select a rectangle to zoom into. 

• Hold the Shift button and right-click on the Map to zoom out. 

• Click the Full Extent (globe icon) button on the Toolbar to return to the full view of the 
map. 

• Click the Previous Extent (left-pointing arrow icon) button on the Toolbar to go to the 
previous view of the map. 

Spend a few minutes experimenting with these different ways of navigating on 
the Map. The simplest way to navigate is to use the buttons in the Toolbar. Note 
each time you change the view, that is the extent of the map, the Scale value in 
the lower right corner of the Plan Interface changes. 

   

Related Topics: 

Plan Interface Toolbar 
Using Zoom In 
Extent drop-down box 
Locator Map 
Map 
District Palette 
Using Zoom Out 
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Lesson 4: Customizing the Map 
As you navigated around the Map in Lesson 3, you may have realized that 
different lines were visible on the map at different extents. Look closely at the 
Theme Manager to the left of the Map. Several types of lines are listed, as well 
as Plan Fill, Plan Label, and Plan Visible, each with an adjacent checkbox. When 
the box is checked, the feature is active. Experiment with these checkboxes to 
see the effects of turning them off and on. 

• Plan Fill controls whether the district shapes appear shaded on the map or merely as 
outlines of the district shapes. 

• Plan Label controls whether the district numbers identifying the district shapes 
appear on the map. 

• Plan Visible controls whether the plan fill/outline is visible on the map or not. If Plan 
Visible is not checked, neither Plan Fill nor Plan Label will be visible. 

The Census Bureau has divided Florida into 362,499 Census Blocks. These are 
grouped into 9,112 Block Groups, which are in turn grouped into 3,154 Tracts, 
which are grouped into 67 Counties. The lines on the map show the boundaries 
of Census geography, but not all lines are visible at all times. The more you 
zoom in, the more lines you will see. You can turn these lines on and off by 
checking and unchecking the boxes in the Theme Manager. 
The Theme Manager also allows you to add themes to the Map. Click on the + 
(plus) button at the top of the Theme Manager. The Theme Organizer will 
appear with a list of choices. Double-click Geography. Double-click Streets. On 
the right side of the Theme Organizer double-click Streets & Highways. This is a 
large theme and may take a minute to load. Now your map will show red lines 
indicating where the highways are. As you zoom into the Map, you will see more 
streets. This is just one of many layers that can make the Map more useful. 
The Theme Manager also allows you to remove themes from the Map. Highlight 
the theme you want to remove, so that it appears shaded in blue in the Theme 
Manager and click the - (minus) button. A dialog will appear asking you to 
confirm that you want to remove the theme. You cannot remove Plan Fill, Plan 
Label or Plan Visible. 
Take a few minutes to look through the Theme Organizer (click the plus button). 
Try adding and removing different themes to and from the map to see the visual 
effect as you zoom in and out and check and uncheck each theme's checkbox. 
Some themes are labels that identify county names or population values. Some 
themes shade the entire map with values associated with voter registration, 
racial, or economic data. 
 
Related Topics: 
 
Map 
Theme Manager 
Theme Organizer 
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Lesson 5: Starting a New Plan 

MyPlan is an example of a complete plan. Frequently, however you will start with 
an empty plan. To open an empty plan click the New (blank page icon) button on 
the Toolbar. The New Plan dialog will open. Name your plan MyOtherPlan. 
Select Congress for the plan type. The number of districts will default to 25 (the 
legally required number of districts for a Congressional plan of Florida). 

MyOtherPlan will open with the outline of the State of Florida. The Statistics 
Grid contains a single record for district 0 with a deviation of 15,982,378, the 
official 2000 Census population count for Florida. By default, district 1 is the 
Active District.  

• On the far right of the Toolbar, click on the Assignment Level Dropdown box (by 
default it says "Tract") to select the Assignment Level. Choose County from this 
dropdown box. 

• Select the Lasso (polygon icon) button from the Toolbar. Notice how the mouse 
pointer becomes a pencil when you held over the Map. 

• Starting at the westernmost edge of the state, click with the pencil icon in each of the 
first four counties. As you click, you will see a shape shaded blue. It starts as a point, 
then a line, then a triangle. The shape changes each time you click. This shape is 
called the lasso. 

• Double-click on the Map to select the last point and complete the lasso. All 
Assignment Level geography intersected by the lasso is assigned to the Active 
District when the lasso is completed. In this case, the four counties in the Florida 
Panhandle intersected by the lasso are assigned to district 1. 

• Select the Point Select Tool (dot icon) button from the Toolbar. 

• Click on district 2 in the District Palette. 

• Click on Monroe County, the very southernmost county in Florida. Notice that the 
county was selected as soon as you clicked. The Point Select Tool is useful for 
selecting a single piece of geography with one click. 

Related Topics: 
 
Creating a New Plan 
Statistics Grid 
Selecting the Active District 
Selecting the Assignment Level 
Using the Lasso 
Using the Point Select Tool 
District Palette   
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Lesson 6: Using the Statistics 

Look at the Deviation column in the Statistics Grid. The value for district 1 is -
16,043. This means that district 1 contains 16,043 fewer people than its target 
population. The next column, TPop00 shows that it contains 623,252 people. 
Other columns in the statistics grid tell us more about the people currently 
assigned to that district.  

• Hold the mouse over each column to see a longer description of what is in that 
column.  

• Double-click the TPop00 column to freeze the first three columns in the Statistics 
Grid.  

• Use the scrollbar to scroll to the right and see additional statistics for your district.  

• Right-click on the Statistics Grid and choose Unfreeze Columns from the menu.  

• Right-click on the Statistics Grid again and choose Statistics of Interest to see all of 
the statistics that are available. 

Spend some time experimenting with different options in the Statistics Grid. You 
can use these statistics to help guide you toward drawing districts that meet your 
goals. 
 
 
Related Topics: 
 
Statistics Grid 
Statistics of Interest 

 
 



 

 

15 

Lesson 7: Using Multiple Plans 

From the Window menu, select Tile Vertical to show the two open plans, 
MyPlan and MyOtherPlan, side by side. FREDS 2000 will allow you to copy a  
district from one  plan to another. This can be a useful tool for consolidating 
districts from different draft plans. For example, you can copy district 4 from 
MyPlan and assign it to district 3 of MyOtherPlan. 

• Click on MyPlan to make it active. The title bar for the active plan is highlighted, 
usually in blue. 

• Click district 4 in the District Palette to make it the Active District. 

• Click the Copy button in the Toolbar. 

• Click on MyOtherPlan to make it active. 

• Click district 3 in the District Palette to make it the Active District. 

• Click the Paste button in the Toolbar. 

• A message dialog will ask you to confirm that you want to paste district 4 from 
MyPlan into district 3. Click the Yes button. 

• Notice how MyOtherPlan changes. The statistics for district 3 are the same as the 
statistics in district 4 of MyPlan. 

Save MyOtherPlan by clicking the Save button on the Toolbar. Click on MyPlan 
to make it the current plan and click the Save button again. Switching between 
multiple plans can take some practice to eliminate confusion.  
 

Related Topics: 
 
Window Menu 
District Palette 
Selecting the Active District 
Cut, Copy, and Paste 
Saving a Plan 

Where to Go From Here 

This tutorial has introduced you to the basic skills needed to build redistricting 
plans in FREDS 2000. Additional information on these and other topics is 
available in the FREDS 2000 help files. Click the Help (question mark icon) 
button on the Toolbar to see an index of help topics. 
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Using FREDS 2000 

Creating a New Plan 

To create a new plan, you may either choose New from the File menu  
 or click on the New Plan icon:  

 

The New Plan dialog will appear. 

 

In the upper right of the dialog, select whether you want to create a House, 
Senate, Congress, or Other plan. The number of districts will change according 
to the type of plan you have chosen. Type a name for your plan into the space 
below New File Name. 

The left half of the form allows you to choose where your plan files will be stored. 
The default location for plans is C:\Data\Freds 2000.  

FREDS 2000 will not allow you to create duplicate plan names. 
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Opening an existing Plan 

To open an existing plan you may either choose Open from the File menu or 
click on the Open Plan icon:  

 

The Open Plan dialog will appear. 

 

On the left side of the dialog select the drive and directory where your plan is 
located. The default directory for plans is C:\Data\Freds 2000. A list of available 
plans will appear to the right of the drive and directory boxes. Select the plan you 
wish to open. The type of plan and number of districts will appear on the right 
side of the dialog. Existing comments for the plan will appear in the comments 
box.  

Click the OK button to open the plan or click the Cancel button to exit the Open 
Plan dialog without opening a plan. 
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Importing a Plan 

Importing a plan can be necessary if an existing plan becomes corrupt, if a plan 
in progress has crashed, or if a plan was created with an old version of the 
statistics data. Importing a plan is a useful step in finalizing a plan because it 
recreates the map and statistics components of the plan from assignment 
information. A newly imported plan will always show statistics and map 
information correctly and can sometimes reveal corrupted shape files. 

Importing a plan can take a significantly long time depending on the number of 
districts in a plan and the complexity of the shapes. Importing can take from 5 to 
30 minutes. 

To import a plan, select Import from the File menu. The Open dialog box will 
appear. 

 

Select a file to import. Files that were created in FREDS 2000 with a .txt or .bak 
extension may be imported.  
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If you currently have no plans open in FREDS 2000, or if the plan you are trying 
to open has more districts than the current plan, the New Plan dialog will appear 
and prompt you to name a new plan into which you will import the file you have 
chosen. 

 

If you already have a plan open in FREDS 2000 that has a similar number of 
districts to the plan you are trying to import, a dialog will appear asking if you 
want to import into the current plan. 

 

Click Yes to import into the current plan. Click No to create a new plan into which 
the plan you have chosen will be imported. 

If you import a plan into your current plan, the imported districts will overwrite 
existing districts with the same number. In this case, run Repair Plan from the 
Utilities menu to clarify and fix district conflicts. 
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Convert FREDS 2000 Plan to DOJ Format 

Converting your FREDS 2000 Plan to United States Department of Justice (DOJ) 
format creates a copy of your plan's assignment file using standard DOJ 
geography identifiers. The FREDS 2000 Save function creates a .txx assignment 
file ordered by district number. The Convert function uses this .txx file to create a 
file that describes the same district geography using the DOJ geographic 
identifiers. 

To convert a plan to DOJ format close all plans. Select Convert FREDS 2000 to 
DOJ from the File menu in the Shell Interface. The Open dialog will appear, 
prompting you to select the file you wish to convert. A message will appear 
alerting you when the conversion is complete. The resulting file will have the 
same name as the original plan, with the suffix  _doj.txt. For a plan named 
MyPlan, the conversion function creates a DOJ formatted file called 
MyPlan_doj.txt. 

The DOJ format is a standard defined by the federal government that allows 
plans from different redistricting software to be used interchangeably. 

See DOJ Format Specifications for further information. 

Convert DOJ to FREDS 2000 Plan 

Converting a Department of Justice (DOJ) format file to FREDS 2000 creates a 
copy of the DOJ file that FREDS 2000 is able to import to recreate the plan. The 
DOJ file must conform to United States Department of Justice file format 
specifications. Further, though not required by DOJ, the file may only contain one 
plan and the plan must be in ascending order by district number. 

To open a DOJ file in FREDS 2000 close all plans. Select Convert DOJ to 
FREDS 2000 from the File menu in the Shell Interface. The Open dialog will 
appear, prompting you to select the file you wish to convert. A message will 
appear alerting you when the conversion is complete. The resulting file will have 
the same name as the original plan, with the suffix  _fromDOJ.txt For a plan 
named MyPlan, the conversion function creates a DOJ formatted file called 
MyPlan_fromDOJ.txt. 

One important requirement of this import is that the plan file be sorted in 
ascending order of district numbers. (The district numbers need not be a 
continuous sequence.) This can be accomplished by importing the plan into a 
database program such as Microsoft Access, sorting the table by district number, 
and then exporting the plan back out as a text file. 
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The DOJ format is a standard defined by the federal government that allows 
plans from different redistricting software to be used interchangeably. 

See DOJ Format Specifications for further information. 

DOJ Format Specifications 

The following are the official specifications of the DOJ format: 

Code of Federal Regulations 

Title 28, Volume 2, Part 43 to end 

Revised as of July 1, 2000 

From the U.S. Government Printing Office via GPO Access 

CITE: 28CFR51.28 

[Pages 84-86] 

TITLE 28--JUDICIAL ADMINISTRATION (Continued) 

PART 51--PROCEDURES FOR THE ADMINISTRATION OF SECTION 5 OF 
THE VOTING RIGHTS ACT OF 1965, AS AMENDED--Table of Contents 

Subpart C--Contents of Submissions 

Sec. 51.28 Supplemental contents. 

Review by the Attorney General will be facilitated if the following information, 
where pertinent, is provided in addition to that required by Sec. 51.27. 

(a) Demographic information. 

(1) Total and voting age population of the affected area before and after the 
change, by race and language group. If such information is contained in 
publications of the U.S. Bureau of the Census, reference to the appropriate 
volume and table is sufficient. 

(2) The number of registered voters for the affected area by voting precinct 
before and after the change, by race and language group. 

(3) Any estimates of population, by race and language group, made in 
connection with the adoption of the change. 
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(4) Demographic data provided on magnetic media shall be based upon the 
Bureau of the Census Public Law 94-171 file unique block identity code of state, 
county , tract , and block. 

(5) Demographic data on magnetic media that are provided in conjunction with a 
redistricting shall be contained in a table of equivalencies giving the census block 
to district assignments in the following format: 

(i) Each census block record (including those with zero population) will be 
followed by one or more additional fields indicating the district assignment for the 
census block in one or more plans. 

(ii) All district assignments in the plan fields shall be right justified and blank filled 
if the assignment is less than four characters. 

(iii) The file structure shall be as follows: 

PL 94-171 

Field Reference name Length Data type 

State  STATEFP 2  Numeric 

County  CNTY 3  Numeric 

Tract  TRACT/BNA 6  Alpha/Numeric 

Block  BLCK 4  Alpha/Numeric 

Plan 1 District  User supplied  4  Alpha/Numeric 

Plan 2 District  User supplied  4  Alpha/Numeric 

Plan 3 District, etc  ...  ...  ... 

Plan n District  User supplied  4  Alpha/Numeric 

(iv) State and county shall be identified using the Federal Information Processing 
Standards (FIPS-55) code. 

(v) Census tracts shall be left justified, and census blocks shall be left justified 
and blank filled if less than four characters. 

(vi) Unused plan fields shall be blank filled. 
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(vii) In addition to the information identified in Sec. 51.20 (c) through (e), the 
documentation file accompanying the block level equivalency file shall contain 
the following information: 

(A) The file structure. 

(B) The total number of plans. 

(C) For each plan field, an identification of the plan (e.g., state senate, 
congressional, county board, city council, school board) and its status or nature 
(e.g., plan currently in effect, adopted plan, alternative plan and sponsors). 

(D) The number of districts in each plan field. 

(E) Whether the plan field contains a complete or partial plan. 

(F) Any additional information the jurisdiction deems relevant such as bill 
number, date of adoption, etc., and a listing of any modifications the submitting 
authority has made that alter the structure of the TIGER/line geographic file. 

Convert Equivalency to FREDS 2000 

Convert Equivalency to FREDS 2000 allows you to import a file similar to the 
DOJ file specified under Convert DOJ to FREDS 2000 except that the Census ID 
and district number are separated by a comma, and the district number does not 
have any leading blanks.  

To open an equivalency file in FREDS 2000 close all plans. Select Convert 
Equivalency to FREDS 2000 from the File menu in the Shell Interface. The 
Open dialog will appear, prompting you to select the file you wish to convert. A 
message will appear alerting you when the conversion is complete. The resulting 
file will have the same name as the original plan , with the suffix  _fromMAP.txt. 
For a plan named MyPlan, the conversion function creates a DOJ formatted file 
called MyPlan_fromMAP.txt. 

One important requirement of this import is that the plan file be sorted in 
ascending order of district numbers. (The district numbers need not be a 
continuous sequence.) This can be accomplished by importing the plan into a 
database program such as Microsoft Access, sorting the table by district number, 
and then exporting the plan back out as a text file. 

See DOJ Format Specifications for further information. 
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Saving a Plan 

To Save a plan, choose Save from the File menu 

 or click the Save Plan icon on the Toolbar  

The plan will be saved with the name that you gave it when you created the plan. 

You may also choose to save a plan with a new name by choosing Save As from 
the File menu and giving the plan a new name. Save As changes the name of 
the open plan to the name under which it was saved. A copy of the old plan may 
still exist with the old name.  

Save As is an effective way to copy plans. You can open a base plan and use 
Save As to create a derivative copy to modify, leaving the original unchanged. 
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Setting up the Map 

FREDS 2000 has some customizable features for which you can save your 
preferences.  

Themes 

Using the Theme Manager you can add and delete themes to the map depicting 
roads, waterways, precinct boundaries,  district boundaries from plans of record, 
economic, demographic, and political data. Once these layers are added to the 
map, you can save them as a default set of themes. To save your current themes 
as default, click Templates on the Map menu and choose Save As Default. 

Statistics of Interest 

Using the User Defined Display Fields dialog you can select from a large 
number of statistics to include in the Statistics Grid. 

District Colors 

To change district colors, double click on the cell in the District Palette 
corresponding to the district that you want to change. Double-clicking causes a 
color palette to appear that allows you to choose the new color for that district. A 
modified district color scheme will remain in effect for the plan that was modified 
but will not apply to other plans. 

You can change any of the settings for these features during any part of your 
work, but you may want to use the customization features to set up the map 
environment when you first begin a plan. 

Creating a District 

To create a district: 
1. Select the active district. 

2. Add geography to the district. 
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Selecting the Active District 

Select the Active District in one of two ways: 

Click on the desired district number in the District palette 

 

Choose Active District from the Settings menu. The Select New District 
palette will appear. Click on the desired district number to make it active. 

 

The Active District is always visible in the title bar for each plan window at the top 
of the screen. 
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Adding Geography to a District 

Select the active district. 

Select the assignment level. 

Zoom in to the area of the map you are selecting. 

Use the lasso tool or point select tool to select the desired geography. 

After you have clicked on the map using the point select tool or double-clicked 
with the lasso tool, FREDS 2000 begins the process of aggregating the selected 
shapes and statistics and integrating them into your plan. This process should 
normally take a few seconds. To reduce the processing time for a selection, 
choose fewer shapes or select at a less granular level of geography. County 
selections are fastest, followed by tract and block group. Block selections can be 
slow. Municipality and Precinct Proxy selections are the slowest. 

If your selection does not give the result you desired, you can use Undo to erase 
the effects of the last selection. If you used the lasso tool to select multiple 
shapes, you can often use Redo to reapply the lasso with different settings. You 
can change the Active District, the Assignment Level, County Locking, or 
District Locking and then reapply the lasso with the Redo feature. 

Selecting the Assignment Level 

Select the Assignment Level in one of two ways: 

Use the Assignment Level Drop-Down Box, located on the FREDS 2000 
toolbar. 

 

Choose Assignment Level from the Settings menu and click on the desired 
level of geography. 

The current Assignment Level is always visible in the Assignment Level Drop-
Down Box. 
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Using the Point Select Tool 

Choose the Point Select Tool by clicking on its button in the toolbar.    

The mouse pointer will change to a pencil. Click on the geography you wish to 
add to the Active District. The selected geographic shape from the current 
Assignment Level will be added to the Active District. You can undo your 
selection by selecting Undo from the Edit menu or from the toolbar.  

Portions of the selected geography that overlap with locked districts or locked 
counties will not be assigned and a message will appear in the Status Bar 
indicating that not all geography was assigned. 
 

Using the Lasso 

Choose the Lasso by clicking on its button in the toolbar   . 

The cursor will change to a pencil. 

The Lasso tool is used to capture multiple units of geography in the current 
Assignment Level. When the Lasso tool is active, each time you click on the 
Map a point is added to the blue lasso polygon. Any geography touched by or 
contained within the Lasso will be added to the Active District when the Lasso 
is completed. To complete the lasso, double-click on the Map. The final segment 
of the lasso then will be drawn between the current cursor location and the first 
point, and the enclosed (or partially enclosed) geography will be assigned to the 
active district. 

In Lasso mode the following mouse clicks are valid:  
 

Click Add a point to the Lasso 

Double-click Assign the Lasso to the Active District 

Shift + click Remove the last point in the Lasso 

Ctrl + click Cancel the Lasso 
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Enlarging a District 

To see a greater level of detail on the map, Zoom In to the  district that interests 
you. As the scale of the map changes, you will see additional features.  

To zoom to a particular district, hold the Shift button and right click (Shift + Right-
click) in the District Palette on the number of the district where you want to 
zoom. 
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Cut, Copy, and Paste 

Cut, Copy and Paste are commands that work together in FREDS 2000, as in 
many Windows™ applications. In FREDS 2000, Cut, Copy and Paste operate on 
the Active District in the current plan. If multiple plans are open, the current plan 
is the one whose window title bar is highlighted.  

Select Cut, Copy or Paste from the Edit menu or click on the Cut, Copy, or 
Paste buttons in the Toolbar. 

Cut will remove the Active District and make a copy of it in a buffer. Cut also 
assigns all of the geography in the Active District to district 0, effectively 
unassigning it. Cut and paste can be used to reassign geography from one 
district to another within the same plan or to assign geography from one plan to 
another. 

Copy will leave the plan intact and make a copy of the current district in a buffer. 
Copy and paste is a useful way to duplicate districts from one plan to another. 

Paste will add a district from a buffer into the Active District of the current plan. 

For example, if you have created a plan MyPlanA that contains district 1 exactly 
as you want it to be added to district 3 of MyMasterPlan, then follow these steps: 

1. Open MyPlanA and MyMasterPlan in FREDS 2000. 

2. Click on the MyPlanA window to make it the Current Plan. 

3. Select District 1 from the District Palette as the Active District. 

4. Click on the Copy button in the Toolbar. 

5. Click on the MyMasterPlan window to make it the Current Plan. 

6. Select District 3 fromt he District Palette as the Active District. 

7. Click on the Paste button in the Toolbar. 

District 3 in MyMasterPlan will now contain its original geography plus all of the 
geography included in district 1 of MyPlanA. 
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Using Zoom In 

To see more detail on your map use one of these three ways to zoom in to the 
desired area. 

• Choose the Zoom In tool by clicking on its button  on the toolbar. The cursor will 
change to a magnifying glass with a + (plus) in the middle. Click and drag on the map 
to select the area to which to zoom. 

• Click and drag on the Locator Map in the lower left corner of the plan screen to zoom. 

• Right-click and drag on the map. 

 
Using Zoom Out 

To see a larger area of your map zoom out.  

• Choose the Zoom Out tool by clicking on its button . The cursor will change to a 
magnifying glass with a - (minus) in the middle. Click on the map to zoom out. 

• Hold the Shift button and Right-click (Shift + Right-click) on the map to zoom out. 

Removing Geography from a District 

Geography that has become part of a district can be unassigned by setting the 
Active District to district 0 and selecting the desired geography with the Lasso 
or Point Select Tool. Also, geography assigned to one district can be 
reassigned to another. 

To erase the effects of the most recent selection click the Undo button in the 
toolbar. 

To remove an entire district, make that district the Active District and choose 
Cut from the Edit menu or click the Cut button on the toolbar. 

Undo 

To undo the last assignment in a plan, press the Undo button    or choose 
Undo from the Edit menu. 
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Redo 

Redo causes the last Lasso to be reapplied with current Assignment Level, 
Active District, District Locking and County Locking settings.  

To redo the last Lasso, select Redo from the Edit menu or click the Redo button 

 on the toolbar. 

Redo can be used to repeat the last assignment if none of these settings have 
been changed. It can modify the effect of the assignment if one or more settings 
have changed. You might select geography using an elaborate Lasso and forget 
to select the correct Active District, or after completing a lasso you may 
discover that you had selected the wrong assignment level or had forgotten to 
"lock" an adjacent district. In cases like these, Redo allows you to change the 
Active District, the assignment level, or district locking and to reassign the 
geography without having to re-create the elaborate Lasso. 

Redo is only available when the last lasso selection was a polygon shape. 
Selections made with the Point Select Tool cannot be repeated using Redo. 
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Theme Manager 

A theme is a layer or group of related layers of information that are added to the 
map to represent data visually. Themes can be lines, labels, points, shading, or a 
combination of visual representations on the map. 

 

To add a theme to the map, click the + (plus) button in the Theme Manager. The 
Theme Organizer will appear, allowing you to select from a variety of available 
themes. You may not add a theme to the map if it is already in the map. If you 
attempt to do so, a message will appear in the Status Bar warning you that the 
theme is already in the map. 

To subtract a theme, click the - (minus) button in the Theme Manager.  Plan Fill, 
Plan Label and Plan Visible may not be removed from the map. If you attempt to 
remove them from the map, a message will appear in the Status Bar warning 
you that the theme may not be removed. 
When a theme is added to the map, its name appears in the Theme Manager. 
To make the theme visible, check the checkbox next to its name. To turn the 
theme off, uncheck the checkbox. 
When you check a theme in the Theme Manager that draws a shaded fill layer on 
the map, the Theme Color Palette will appear at the bottom of the Theme 
Manager showing colors and their corresponding values on the map. Most 
themes are based on percentage values from 0 to 100%. Click and drag the gray 
bar above the Theme Color Palette to resize it. 
See Theme Organizer for additional information on adding themes to the map. 
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Theme Organizer 

You may add or remove features from your list of available themes. To remove a 
theme, click on its name, and then press the - button. To add themes, press the + 
button, or choose Templates: Manage from the Map Menu. This will cause the 
Map Symbols Organizer box to be displayed. All available layers will be shown in 
the box. 

 

  

To display the features in a folder, double-click on it. There are three types of 

features available: fill layers (designated by ), lines (designated by ), and 
labels (designated by ). To add a feature to your list, simply double-click on 
its name and it will appear on the theme manager. 

You have some control over how the fill layers are displayed. To modify fill 
layers, click on the  above any fill layer name. A button will appear on the top 
left of the Organizer box. Click on it, and a Class Break manager will appear. You 
may then change the colors and break points used to display fill layers on the 
map.  
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Finding a Location 

Enable the Find tool by selecting Find from the Tools menu or by clicking the 

Find button on the toolbar.  

The Address Search dialog will appear.  

 

The Address Search dialog allows you to flash or zoom to an address location 
on the map matching to the data you enter. The more complete the data, the 
more accurately the map will select your location. The minimum information 
required is a street address and zip code. Click the Flash button and a small, 
shaded dot will flash three times at the address' location. Click the Zoom button 
and the map will zoom to the area where the address is located. 

If the search is unsuccessful, try searching again with less data. Leave out the 
street number or give a partial ZIP code. 
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Using the Info Tool 

The Info Tool is used to show population, election, and voter statistics for a 
selected piece of geography. 

Choose Info Tool from the Tools menu, or click the Info Tool button    on 
the toolbar. The mouse pointer will change to the information icon. Click on the 
Map to see the categories of information available for that location. The 
categories are listed in the left half of the Identify Results dialog, with a list of 
information sets under each category. Click on an information set to see the 
statistics in the right side of the Identify Results dialog. As you click on each 
information set, the Map will show the area represented by the statistics by 
shading it with red crosshatching. 

 

Summary information in the grid in the Identify Results dialog  is highlighted in 
pink. Estimated values are highlighted in grey. Grey highlights in the "Census" 
and "Voter Registration" tables distinguish classifications of registered voters by 
race and sex or party affiliation. In the "Precinct Election Data" tables, grey 
highlights indicate that individual precinct election results were disaggregated 
(estimated based on registered voters) because the supervisor reported election 
results for combined precincts. Percentage values that cannot be calculated 
(division by zero) appear as either an empty cell or as the value "-1". 
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Using the Distance Tool 

Select the Distance tool by choosing Distance from the Tools menu or clicking 
the Distance Tool icon on the Toolbar. 

The distance tool gives you an approximate distance between two points or 
along a path on the map. 

When you move the mouse pointer over the Map, the mouse icon will change to 
crosshairs. Click on a starting point  and drag the mouse to draw a line. Each 
time you click, the line adds another point. Double-click to complete the 
measurement and the approximate distance in miles will appear in the Message 
Center on the Status Bar. 

Using Statistics 

The Statistics Grid located below the map shows information about the districts 
and counties that have been selected. Use the statistics as a guide when trying 
to meet specific demographic goals in the district building process. The 
Population and Deviation statistics are useful guides for meeting population 
requirements. 

To the left of the Statistics Grid are four radio buttons. Each one groups the 
statistics and displays them in a different way.  

District Shows statistics grouped by district. 
This is the default. 

County Shows statistics, aggregated by county 
within each district (District By County). 

Active Shows the Active District and districts 
changed in most recent assignment. 
Also shows any districts chosen in the 
Districts Of Interest dialog. 

Changed Shows District By County statistics for 
the Active District and districts 
changed in most recent assignment. 
Also shows district by county statistics 
for districts chosen in the Districts Of 
Interest dialog 
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Some column names are too long to fit in the columns. You can view the full 
names in one of two ways. 

• Hold the mouse pointer at the right edge of the column header. When the mouse 
pointer changes to a two-headed arrow, click and drag the column to the right to 
make it wider. 

• Hold the mouse pointer over the column for a couple seconds and a box will appear 
showing the full name of the column heading. 

You can make the Statistics Grid larger or smaller by clicking and dragging the 
gray bar along the top edge of the grid up or down. 

In the Statistics Grid the following mouse clicks are valid:  

Right-click Opens a menu of options. 

Double-click Freezes the selected column and all 
columns to the left of the selected 
column. 

Shift + click Sorts by the selected column in 
ascending order. 

Ctrl + click Sorts by the selected column in 
descending order. 

 
Right-click menu 

Right-click on the Statistics Grid to see a menu of options. 

 

Open Grid in Window causes the Statistics Grid to float in a separate window 
from the plan, allowing you to move it anywhere within the FREDS 2000 
application. To return the Statistics Grid to the plan window, close the statistics 
window and click on one of the View Buttons that shows statistics. 

Statistics of Interest opens the User Defined Display Fields dialog. 
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Unfreeze Columns unfreezes any columns that the user has frozen in the 
statistics grid. Frozen columns do not scroll to the left or right, so unfreezing them 
causes them to once again move as you scroll. 

 
Changing the View 

 

Use the View Buttons on the far left of the Status Bar to change the screen 
view. Click on a button in the image above to see an explanation of the 
corresponding screen view. 
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Locking a District 

While a district is locked it cannot be changed. To access the Lock Districts 
dialog, click the Districts Locked checkbox on the Status Bar 

 

or by choosing Lock from the Settings menu and selecting Districts. Either of 
these actions open the Lock Districts dialog. 

 

Check the checkboxes of the districts you want to lock. Click the Select All 
button to lock all districts or the Select None button to unlock all districts. Click 
Okay when you are finished.  

If one or more districts are locked, the Districts Locked checkbox will appear 
checked. If no districts are locked, the Districts Locked checkbox will be 
unchecked. 

Locked districts will appear in the District Grid with red numbers while unlocked 
districts will have black numbers in the District Grid. 
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For one-click locking, right-click on the cell with the district number you want to 
lock in the District Grid. You will see the district number change to red when it is 
locked. Right-click again and the district is unlocked and the number becomes 
black. 

Districts that are locked when you save a file will be locked when you re-open the 
file. However, district locking is not preserved when you import a  plan .  

 
Locking a County 

While a county is locked, its geography cannot be reassigned. To access the 
Lock Counties dialog, click the Counties Locked indicator on the Status Bar 

 

or choose Lock from the Settings menu and select Counties. Either of these 
actions cause the Lock Counties dialog to appear. 
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Check the checkboxes of the counties you want to lock. Click the Select All 
button to lock all counties or the Select None button to unlock all counties. Click 
Okay when you are finished.  

If one or more counties are locked, the Counties Locked checkbox will appear 
checked. If no districts are locked, the Counties Locked checkbox will be 
unchecked. 

Unlike district locking, county locking is not saved in the plan file when you save 
your plan.  

Using Statistics Outside FREDS 2000  

FREDS 2000 automatically creates a comma separated statistics file each time 
you save a plan. This file has the same name as your plan with the extension 
".csv". The comma separated file can be opened by Microsoft® Excel. Advanced 
users may wish to create Excel templates to generate charts or reports based on 
the comma separated statistics. 

FREDS 2000 incorporates a Crystal Reports™ module that contains a District 
Report. To view these reports, select Print Report from the Utilities menu. 
These standardized reports allow you to print a formatted hard copy of a plan's 
statistics. 
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Re-creating a Corrupted Plan 

Every time you assign geography, FREDS 2000 updates a backup file for your 
plan. The file is in the same folder where you plan is kept and has a .bak 
extension. You may need to restore your plan from this backup file if your plan 
becomes corrupt or if your FREDS 2000 session is interrupted before you have 
saved your latest changes.  

Plans may become corrupted through spatial errors. Before finalizing a plan, you 
should import a copy of the plan to compare with the original. Differences in the 
map or statistics indicate that corruption has occurred. If this is the case, use the 
imported copy of the plan, make corrections as necessary, and discard the 
original. 

To restore your plan  

1. Select Import from the File menu.  

2. When the Open dialog appears, choose Files of Type "Backup Files (*.bak)" 

3. Select the backup file for the plan you want to restore and click the Open button. 

4. If a dialog appears asking whether you want to import into the current plan, click the No 
button.  

5. The New Plan dialog will appear. Make sure that the Plan Type and Number of 
Districts are consistent with the plan you are trying to restore.  

6. Name the plan and click the OK button. 

Repairing a Plan 

This utility re-creates each district's shape from the geography that has been 
assigned to each district. It corrects for any spatial errors that may have occurred 
during construction of the plan.  

Printing a Plan 

Choose Print by either selecting Print from the File menu or clicking the Print 
button on the Toolbar. 

Print allows you to print the current view of the Map. It opens a form that 
contains a screen capture of the Map. The form's header information 
automatically shows the plan name and type in the upper left corner and the 
current time and date in the upper right corner. In addition, the form allows you to 
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type in a caption that will appear centered at the bottom of the printout. Click the 
Print button to print the map or click Cancel to return to FREDS 2000 without 
printing. 

Warning: Some printers may be overwhelmed by the size of the files being 
printed. 
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Printing Reports 

Choose Print Reports from the Utilities menu. 

 

 
Choose the District or District By County report and click the Okay button. The 
Crystal Reports™ report viewer will appear, showing the report you have 
selected.  

 



 

 

46 

To print the report, click the Print icon.  

To close the Report Viewer, click the Close button at the bottom of the viewer. 

For more information, see Report Viewer. 

A collective term referring to the geographic entities used by the U.S. Census 
Bureau in its data collection and tabulation operations, including their 
relationships to one another. 

Finalizing Your Plan 

It is possible for a plan to be corrupt without showing any visible signs. Therefore, 
when you have finished building your plan, you should repair it before 
considering it complete. 

See Repairing a Plan for more information. 

A collective term referring to the geographic entities used by the U.S. Census 
Bureau in its data collection and tabulation operations, including their 
relationships to one another. 
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Shell Interface 

Shell Interface Menu 

When you launch FREDS 2000 the menu shows two choices: File and Help. 

 

File Menu (Shell Interface) 

When you launch FREDS 2000, the File menu presents the following options: 

 

Help Menu 

Functions available from the Help menu allow you to access the help file and get 
version information about FREDS 2000. 

The Help menu presents the following options: 
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Shell Interface Toolbar 

When you launch FREDS 2000 the following toolbar is part of the default screen. 
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Plan Interface 

View of the Plan Interface 

 

 
 
Plan Interface Menu 

Once a plan is open, the following menu bar will appear. 
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File Menu 

When a plan is open, the File Menu presents the following options: 
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Edit Menu 

The Edit Menu presents the following options: 

 

 
Settings Menu 

The Settings Menu presents the following options: 

 

 

Map Menu 

The Map Menu presents the following options: 
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Tools Menu 

The Tools Menu presents the following options: 

 

 
Utilities Menu 

The utilities menu presents the following options: 

 

 

Window Menu 

The Window Menu presents the following options: 
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Plan Interface Toolbar 

Once a plan is open, the following toolbar will appear. Click on an icon to receive 
an explanation of its action. 

 

 
Extent drop-down box 

The Extent drop-down box appears on the right of the Plan Interface toolbar. 

 

This bar is used to display pre-designated areas of the map, called an extent. 
You may save the current extent for future retrieval using this box also. 

A collective term referring to the geographic entities used by the U.S. Census 
Bureau in its data collection and tabulation operations, including their 
relationships to one another. 
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Assignment Level drop-down box 

The Assignment Level drop-down box appears on the right of the Plan Interface 
toolbar. 

 

The box is used to select the level at which geography is to be added to a plan. 
The Lasso and Point Select tools will operate at the level of geography displayed 
in the box. 

Four levels of Census Geography are available for building plans.  

At block level, assignments of individual census blocks are made. There are 
362,499 census blocks in Florida. 

The Census Bureau groups adjacent blocks into areas called block groups. 
There are 9,112 block groups in Florida. 

Tracts are defined by the Census Bureau and are made up of whole block 
groups and are wholly contained within a county. There are 3,154 tracts in 
Florida. 

The county is the largest level of geography that can be selected. There are 67 
counties in Florida. 

    Two other assignment levels are available. 

Precinct proxies are approximations of precinct boundaries for the 2000 elections 
constructed entirely of whole census blocks. Where precinct boundaries match 
census block boundaries, the approximation is exact. Many precinct boundaries 
in Florida do not line up exactly with census block boundaries. In those cases, 
the precinct proxy will not match the official precinct boundaries set by the 
county. Using precinct proxies for building districts may reduce the impact of new 
districts on precincts. 

At the municipality level, assignments of entire municipalities or Census 
Designated Places (CDP's) occur. Municipalities are incorporated areas as 
defined by the Census.  When using this assignment level, be aware of two 
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features of this layer.  First, if you add a municipality that surrounds 
unincorporated areas or other municipalities, those inholdings also will be 
included in the assignment. Conversely, if a municipality has discontiguous 
pieces, those pieces will not be included in the assignment, but must be selected 
individually. This assignment level provides a useful shortcut for including 
particular municipalities or CDP's in a district. Because many areas of the state 
are not included in this assignment level, completing a plan will require using 
other assignment levels. 

  

Map 

The map area is a rectangle which contains the current map extent. When a plan 
is first opened, the entire state is shown, and any districts already defined will 
show on the map.  

 

Using the zoom in and out tools, the extent may be changed, allowing detail for 
some themes to be visible. 

 



 

 

56 

Legend 

The Legend lies to the left of the Map when a plan has been loaded.   

Click on an area of the legend for an explanation. Click and drag the thin, gray 
border on the right side of the Legend to resize it.  
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District Palette 

 

Use the District Palette to select the Active District. Click on the number of the 
district you want to make active. That district number will appear in the plan 
window's title bar. Any assignments you make with the Lasso or Point Select 
Tool will be added to that district. 

To change a district's color double-click the district number and select a new 
color from the color palette. The district shape will change to the new color you 
have chosen but this change will only apply to the current plan. 

For one-click district locking, right-click on the cell with the district number you 
want to lock. You will see the district number change to red when it is locked. 
Right-click again and the district is unlocked and the number becomes black. 
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Locator Map 

The Locator Map is in the lower left corner of the plan. It shows you what part of 
the state is currently shown in the map display. The locator allows you to change 
the current view. The locator map is a handy tool for quickly zooming to a 
location without having to click the toolbar and the Map.   

To change the extent of the Map, click and drag on the Locator Map to create a 
rectangle over the area of the state you want to view. The Map will zoom to the 
extent of the rectangle you have drawn in the Locator Map.  

The locator map will always contain a diagonally shaded rectangle showing 
where in the state the Map extent is, although the rectangle may sometimes be 
too small to see. When you open a plan the shaded rectangle will be around the 
entire map of Florida and the Map will show the whole state. 

Statistics Grid 

 

The statistics grid shows Statistics of Interest for chosen geography. Click and 
drag the gray border at the top of the Statistics Grid to resize it. 

Clicking the District radio button shows the statistics for all defined districts.  

The County radio button shows the statistics by county.  

Active shows districts affected by the last selection.  

Changed shows district by county affected by the last selection. 

See Using Statistics for more information. 
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Status Bar 

The status bar contains five active areas. From left to right, they are: 
  

           
• View Buttons change the view of the map. 

 

 
• Districts Locked checkbox indicates if any districts are locked 

 

 
• Counties Locked checkbox indicates if any counties are locked  

 

 
• Message Center shows messages that indicate what FREDS 2000 is doing. 

 

 
• Scale shows the approximate ratio of screen size to actual size.  
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Plans 

What is a Plan 

The end product that a user creates with FREDS 2000 is a redistricting plan . 
The State of Florida is divided into discrete pieces of geography defined by the 
United States Census Bureau. The plan is a correlation between each piece of 
geography in the state and the district to which it is assigned. FREDS 2000 will 
create three distinct, but correlated symbolic representations of the plan:  

• the ESRI© shapefile, which is a visual representation of the plan. 

• the assignment file, which contains geography ID numbers and corresponding district 
numbers.  

• the statistics file, which describes the demographic makeup of each district. 

These representations of the plan are encapsulated in nearly a dozen files that 
contain information for each plan. For example, a plan named MyPlan consists of 
the following files: MyPlan.pln, MyPlan.shp, MyPlan.shx, MyPlan.dbf, MyPlan.st1, 
MyPlan.st2, MyPlan.txt, MyPlan.csv, MyPlan.map, MyPlan.fld, and MyPlan.sym. 
These files should only be modified using FREDS 2000. The plan can be 
reconstructed by importing the MyPlan.txt file. 

In case of disaster, the file with the .bak extension is the one file necessary to 
recover the plan. FREDS 2000 can regenerate the remaining files by importing 
the .bak file. 

Where to store plans 

You can store a  plan anywhere on your hard drive or network, but the default 
location for plans is in C:\Data\Freds 2000.  

A collective term referring to the geographic entities used by the U.S. Census 
Bureau in its data collection and tabulation operations, including their 
relationships to one another. 
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Renaming a Plan 

Open your plan and select Save As from the File menu to create a copy of the 
plan with a new name. 

The open plan will have the new file name. A copy of the old plan will still exist 
with the old name. 

Save As is an effective way to copy plans. You can open a base plan and use 
Save As to create a derivative copy to modify, leaving the original unchanged 

A collective term referring to the geographic entities used by the U.S. Census 
Bureau in its data collection and tabulation operations, including their 
relationships to one another. 

Copying a Plan 

See Renaming a Plan. 

Missing or Lost Plan 

See Recreating a Corrupted Plan. 

Completeness of a Plan 

You may check for a plan's completeness by choosing Completeness from the 
Utilities menu. A plan is considered complete by FREDS 2000 if all units of 
geography have been assigned to a district, and if each district has some 
geography assigned to it. 

 

You may click on the Click to Zoom button to zoom to the area that is not 
assigned. The Map will zoom to the block group containing the first unassigned 
block . 

Click the right arrow to go to the next unassigned geography. If a block group 
contains multiple unassigned blocks, the map will zoom again to the same block 
group for each unassigned block. 
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If all geography has been assigned, the right and left arrows will be disabled and 
the message between them will say "All geography has been assigned."  

 

This tool is intended for cleaning up after a plan is nearly complete. Once a plan 
appears to have all geography assigned, but District 0 still contains some 
population, the Completeness tool will help you find and assign the remaining 
geography. Using it too early in the process of building your plan will cause 
frustration and confusion and will waste time. 

Contiguity of a Plan 

State law requires all districts to be composed of contiguous geography. This 
means that no part of a district can be geographically disconnected from the rest 
of the district. To check a plan for  contiguity choose Contiguity from the 
Utilities menu. 

The Discontiguous Districts dialog will appear and will refresh itself to stay on 
top of the Map until you click the Close button. To update the list of 
discontiguous districts, close the dialog and select Contiguity from the Utilities 
menu again.  
 

 

Double-click on a district number to zoom the Map to the discontiguous 
geography. 

Right-click on a district number to choose how tightly to zoom in on the 
discontiguous piece. The default value is Wide. 
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NOTE: The district which contains the Marquesas Keys in Monroe County will 
always show as not contiguous. 

Orphan and Straggler Assignment 

The Orphan and Straggler Assignment utility is an automated approach to 
handling completeness and  contiguity issues. An orphan is a piece of geography 
that is unassigned. A straggler is a part of a district that is not attached to the 
main district shape and is completely surrounded by another district. 

To Select Orphan and Straggler Assignment, choose Assign Orphans from the 
Utilities menu. The Orphan and Straggler Assignment dialog will appear. By 
default no districts are selected and both the Assign Orphans and Assign 
Stragglers checkboxes are checked. 

Checking the checkboxes for districts you want to affect. If you do not want to do 
both orphan and straggler assignment, uncheck the checkbox for the operation 
you do not want to perform. If you choose both, orphan assignment occurs first. 

NOTE: Be sure to Save your plan before you run Orphan and Straggler 
Assignment. It may make multiple changes that you cannot Undo. 

Orphan Assignment 

Orphan Assignment affects unassigned geography and geography assigned to 
district 0. For each district on which this function is performed, all districts except 
the target district are locked. The existing district shape is used as a lasso to 
perform a  tract level assignment on the map. All adjacent unassigned geography 
up to one tract-width will be assigned to the district. If you select multiple districts, 
the assignments are done in ascending order by district number. When orphan 
assignments for all districts are finished, a message will appear in the Message 
Center on the Status Bar that Orphan Assignments are complete 
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Straggler Assignment 

Straggler Assignment affects discontiguous shapes within a district. For each 
district on which this function is performed, all parts of other districts that are 
wholly contained by the target district will be assigned to the target district. Each 
district may have multiple assignments. When all of the straggler assignments 
have finished, a message will appear in the Message Center on the Status Bar 
that Straggler Assignments are complete. 

Straggler assignment goes a long way in correcting discontiguities, but it is by no 
means a complete solution. It only assigns wholly contained discontiguous parts 
of other districts, leaving behind those discontiguities that lie between districts. 
These remaining discontiguities must be dealt with manually, using the 
Contiguity utility. 

Orphan and Straggler Assignment can be a very time-consuming process, taking 
up to an hour or more for a complete plan . Be selective in how you use it. It is 
intended for use in the final stages of building a plan.  When all geography 
appears to be assigned and districts are approximately equal, save the plan and 
run the Orphan and Straggler Assignment. For a complete, contiguous plan, 
Orphan and Straggler Assignment should cause no changes. 
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Layers and Themes 

How to display themes 

To display a theme on the Map either select Templates from the Map file and 
choose Manage or click the + (plus) button at the top of the Theme Manager in 
the Legend.   

Either of these will open the Theme Organizer dialog. The left window of the 
Theme Organizer allows you to navigate through a hierarchy of themes. As you 
navigate, available themes will appear in the right window of the Theme 
Organizer.  

To add a theme to the Map, simply double click its name in the right side of the 
Theme Organizer. The theme name will appear in the plan 's Theme Manager 
with a checkbox. Click the checkbox to turn on the layer. Some layers may not be 
visible from all map scales. You may need to Zoom In to view the theme's 
features.  

  

How to remove themes 

To remove a theme from the Map, click on the theme's name in the Theme 
Manager so that it is highlighted in blue. Click on the - (minus) button at the top 
of the Theme Manager. A dialog will appear asking you to confirm that you wish 
to remove the layer. Click the Yes button to remove the layer or No to cancel.  

You cannot remove Plan Fill, Plan Label or Plan Visible from the Map. If you 
attempt to do so, a message will appear in the Status Bar alerting you that the 
layer may not be removed. 
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Legends 

When you add a thematic fill layer to the map, a legend opens beneath the 
theme manager. For most themes, this legend shows all of the class breaks. For 
themes involving the breakdown of Voting Age Population and Registered Voters 
by race, the legend does not show all 36 of the class breaks. The full breakout of 
the class breaks is shown in the figures below.          

5 Percent Increments 15 Percent Increments 
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Available Themes 

Elections 

Election Results 

1992 Election Results 

These themes use shading to show party advantage in Presidential, United 
States Senate, United States Representative, State Senate, and State 
Representative races in 1992.  

For all elections themes, data are depicted at the precinct level, more saturated 
reds indicate increasing advantages for the Democratic candidate, and more 
saturated blues indicate increasing advantages for the Republican candidate.  

For the composites, in cases where a precinct is in more than one district, votes 
for all candidates of the same party are added together.  

G92PRE_D Clinton This theme depicts the percentage of votes cast for Bill Clinton 
for President in the 1992 General Election, relative to total votes 
cast for the three leading candidates. 

G92PRE_I Perot This theme depicts the percentage of votes cast for Ross Perot 
for President in the 1992 General Election, relative to total votes 
cast for the three leading candidates. More saturated greens 
indicate increasing percentages for Perot. 

G92PRE_R Bush This theme depicts the percentage of votes cast for George 
Bush for President in the 1992 General Election, relative to total 
votes cast for the three leading candidates. 

G92STR_D 
Composite 

This theme depicts the difference between the percentage of 
votes cast for Democratic candidates for State Representative in 
the 1992 General Election, and the percentage of votes cast for 
Republican candidates.  

G92STR_R 
Composite 

This theme depicts difference between the percentage of votes 
cast for Republican candidates for State Representative in the 
1992 General Election, and the percentage of votes cast for 
Democratic candidates.  
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G92STS_D 
Composite 

This theme depicts difference between the percentage of votes 
cast for Democratic candidates for State Senate in the 1992 
General Election, and the percentage of votes cast for 
Republican candidates.  

G92STS_R 
Composite 

This theme depicts difference between the percentage of votes 
cast for Republican candidates for State Senate in the 1992 
General Election, and the percentage of votes cast for 
Democratic candidates. 

G92USR_D 
Composite 

This theme depicts difference between the percentage of votes 
cast for Democratic candidates for United States Representative 
in the 1992 General Election, and the percentage of votes cast 
for Republican candidates.  

G92USR_R 
Composite 

This theme depicts difference between the percentage of votes 
cast for Republican candidates for United States Representative 
in the 1992 General Election, and the percentage of votes cast 
for Democratic candidates.  

G92USS_D Graham This theme depicts difference between the percentage of votes 
cast for Bob Graham for United States Senate in the 1992 
General Election, and the percentage of votes cast for Bill Grant. 

G92USS_R Grant This theme depicts difference between the percentage of votes 
cast for Bill Grant for United States Senate in the 1992 General 
Election, and the percentage of votes cast for Bob Graham. 
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1994 Election Results 

These themes use shading to show party advantage in Presidential, United 
States Senate, United States Representative, State Senate, and State 
Representative races in 1994.  

For all elections themes, data are depicted at the precinct level, more saturated 
reds indicate increasing advantages for the Democratic candidate, and more 
saturated blues indicate increasing advantages for the Republican candidate.  

For the composites, in cases where a precinct is in more than one district, votes 
for all candidates of the same party are added together.  

G94GOV_D Chiles This theme depicts difference between the percentage of votes 
cast for Lawton Chiles for Governor in the 1994 General 
Election, and the percentage of votes cast for Jeb Bush.  

G94GOV_R Bush This theme depicts difference between the percentage of votes 
cast for Jeb Bush for Governor in the 1994 General Election, 
and the percentage of votes cast for Lawton Chiles.  

G94STR_D 
Composite 

This theme depicts difference between the percentage of votes 
cast for Democratic candidates for State Representative in the 
1994 General Election, and the percentage of votes cast for 
Republican candidates.  

G94STR_R 
Composite 

This theme depicts difference between the percentage of votes 
cast for Republican candidates for State Representative in the 
1994 General Election, and the percentage of votes cast for 
Democratic candidates.  

G94STS_D 
Composite 

This theme depicts difference between the percentage of votes 
cast for Democratic candidates for State Senate in the 1994 
General Election, and the percentage of votes cast for 
Republican candidates.  

G94STS_R 
Composite 

This theme depicts difference between the percentage of votes 
cast for Republican candidates for State Senate in the 1994 
General Election, and the percentage of votes cast for 
Democratic candidates.  

G94USR_D 
Composite 

This theme depicts difference between the percentage of votes 
cast for Democratic candidates for United States 
Representative in the 1994 General Election, and the 
percentage of votes cast for Republican candidates.  
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G94USR_R 
Composite 

This theme depicts difference between the percentage of votes 
cast for Republican candidates for United States 
Representative in the 1994 General Election, and the 
percentage of votes cast for Democratic candidates.  

G94USS_D Rodham This theme depicts difference between the percentage of votes 
cast for Hugh Rodham for United States Senate in the 1994 
General Election, and the percentage of votes cast for Connie 
Mack. 

G94USS_R Mack This theme depicts difference between the percentage of votes 
cast for Connie Mack for United States Senate in the 1994 
General Election, and the percentage of votes cast for Hugh 
Rodham. 

1994 Election Results--More Statewide Elections 

These themes use shading to depict the results of statewide General Election 
contests in 1994 for cabinet offices and of the Democratic Primary contest in 
1994 for Commissioner of Education.  

For all elections themes, data are depicted at the precinct level, more saturated 
reds indicate increasing advantages for the Democratic candidate, and more 
saturated blues indicate increasing advantages for the Republican candidate.  

G94AGR_D 
Crawford 

This theme depicts difference between the percentage of votes 
cast for Bob Crawford for Commissioner of Agriculture in the 
1994 General Election, and the percentage of votes cast for Jim 
Smith.  

G94AGR_R Smith This theme depicts difference between the percentage of votes 
cast for Jim Smith for Commissioner of Agriculture in the 1994 
General Election, and the percentage of votes cast for Bob 
Crawford.  

G94ATG_D 
Butterworth 

This theme depicts difference between the percentage of votes 
cast for Bob Butterworth for Attorney General in the 1994 
General Election, and the percentage of votes cast for Henry 
Ferro. 

G94ATG_R Ferro This theme depicts difference between the percentage of votes 
cast for Henry Ferro for Attorney General in the 1994 General 
Election, and the percentage of votes cast for Bob Butterworth. 
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G94CMP_D Lewis This theme depicts difference between the percentage of votes 
cast for Gerald Lewis for Comptroller in the 1994 General 
Election, and the percentage of votes cast for Bob Milligan. 

G94CMP_R Milligan This theme depicts difference between the percentage of votes 
cast for Bob Milligan for Comptroller in the 1994 General 
Election, and the percentage of votes cast for Gerald Lewis. 

G94EDU_D 
Jamerson 

This theme depicts difference between the percentage of votes 
cast for Doug Jamerson for Commissioner of Education in the 
1994 General Election, and the percentage of votes cast for 
Frank Brogan. 

G94EDU_R Brogan This theme depicts difference between the percentage of votes 
cast for Frank Brogran for Commissioner of Education in the 
1994 General Election, and the percentage of votes cast for 
Doug Jamerson. 

G94SEC_D 
Saunders 

This theme depicts difference between the percentage of votes 
cast for Ron Saunders for Secretary of State in the 1994 
General Election, and the percentage of votes cast for Sandy 
Mortham. 

G94SEC_R 
Mortham 

This theme depicts difference between the percentage of votes 
cast for Sandy Mortham for Secretary of State in the 1994 
General Election, and the percentage of votes cast for Ron 
Saunders. 

G94TRE_D Nelson This theme depicts difference between the percentage of votes 
cast for Bill Nelson for Treasurer in the 1994 General Election, 
and the percentage of votes cast for Tim Ireland. 

G94TRE_R Ireland This theme depicts difference between the percentage of votes 
cast for Tim Ireland for Treasurer in the 1994 General Election, 
and the percentage of votes cast for Bill Nelson. 

P94EDU Jamerson This theme depicts the percentage of votes cast for Doug 
Jamerson for Commissioner of Education in the 1994 
Democratic Primary, and the percentage of votes cast for John 
Griffin. 
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1996 Election Results 

These themes use shading to show party advantage in Presidential, United 
States Senate, United States Representative, State Senate, and State 
Representative races in 1996.  

For all elections themes, data are depicted at the precinct level, more saturated 
reds indicate increasing advantages for the Democratic candidate, and more 
saturated blues indicate increasing advantages for the Republican candidate.  

For the composites, in cases where a precinct is in more than one district, votes 
for all candidates of the same party are added together.  

G96PRE_D Clinton This theme depicts the percentage of votes cast for Bill Clinton 
for President in the 1996 General Election, relative to the total 
votes cast for the three leading candidates. 

G96PRE_R Dole This theme depicts the percentage of votes cast for Bob Dole 
for President in the 1996 General Election, relative to the total 
votes cast for the three leading candidates. 

G96PRE_I Perot This theme depicts the percentage of votes cast for Ross Perot 
for President in the 1996 General Election, relative to the total 
votes cast for the three leading candidates. More saturated 
greens indicate increasing percentages for Perot. 

G96STR_D 
Composite 

This theme depicts difference between the percentage of votes 
cast for Democratic candidates for State Representative in the 
1996 General Election, and the percentage of votes cast for 
Republican candidates.  

G96STR_R 
Composite 

This theme depicts difference between the percentage of votes 
cast for Republican candidates for State Representative in the 
1996 General Election, and the percentage of votes cast for 
Democratic candidates.  

G96STS_D 
Composite 

This theme depicts difference between the percentage of votes 
cast for Democratic candidates for State Senate in the 1996 
General Election, and the percentage of votes cast for 
Republican candidates.  

G96STS_R 
Composite 

This theme depicts difference between the percentage of votes 
cast for Republican candidates for State Senate in the 1996 
General Election, and the percentage of votes cast for 
Democratic candidates.  
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G96USR_D 
Composite 

This theme depicts difference between the percentage of votes 
cast for Democratic candidates for United States Representative 
in the 1996 General Election, and the percentage of votes cast 
for Republican candidates.  

G96USR_R 
Composite 

This theme depicts difference between the percentage of votes 
cast for Republican candidates for United States Representative 
in the 1996 General Election, and the percentage of votes cast 
for Democratic candidates.  
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1998 Election Results 

These themes use shading to show party advantage in Presidential, United 
States Senate, United States Representative, State Senate, and State 
Representative races in 1998.  

For all elections themes, data are depicted at the precinct level, more saturated 
reds indicate increasing advantages for the Democratic candidate, and more 
saturated blues indicate increasing advantages for the Republican candidate.  

For the composites, in cases where a precinct is in more than one district, votes 
for all candidates of the same party are added together.   

G98GOV_D MacKay This theme depicts difference between the percentage of 
votes cast for Buddy MacKay for Governor in the 1998 
General Election, and the percentage of votes cast for Jeb 
Bush.  

G98GOV_R Bush This theme depicts difference between the percentage of 
votes cast for Jeb Bush for Governor in the 1998 General 
Election, and the percentage of votes cast for Buddy MacKay. 

G98STR_D 
Composite 

This theme depicts difference between the percentage of 
votes cast for Democratic candidates for State Representative 
in the 1998 General Election, and the percentage of votes 
cast for Republican candidates.  

G98STR_R 
Composite 

This theme depicts difference between the percentage of 
votes cast for Republican candidates for State Representative 
in the 1998 General Election, and the percentage of votes 
cast for Democratic candidates.  

G98STS_D 
Composite 

This theme depicts difference between the percentage of 
votes cast for Democratic candidates for State Senate in the 
1998 General Election, and the percentage of votes cast for 
Republican candidates.  

G98STS_R 
Composite 

This theme depicts difference between the percentage of 
votes cast for Republican candidates for State Senate in the 
1998 General Election, and the percentage of votes cast for 
Democratic candidates.  
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G98USR_D 
Composite 

This theme depicts difference between the percentage of 
votes cast for Democratic candidates for United States 
Representative in the 1998 General Election, and the 
percentage of votes cast for Republican candidates.  

G98USR_R 
Composite 

This theme depicts difference between the percentage of 
votes cast for Republican candidates for United States 
Representative in the 1998 General Election, and the 
percentage of votes cast for Democratic candidates.  

G98USS_D Graham This theme depicts difference between the percentage of 
votes cast for Bob Graham for United States Senate in the 
1998 General Election, and the percentage of votes cast for 
Charlie Crist. 

G98USS_R Crist This theme depicts difference between the percentage of 
votes cast for Charlie Crist for United States Senate in the 
1998 General Election, and the percentage of votes cast for 
Bob Graham. 

1998 Election Results--More Statewide Elections 

These themes use shading to depict the results of statewide General Election 
contests in 1998 for cabinet offices.  

For all elections themes, data are depicted at the precinct level, more saturated 
reds indicate increasing advantages for the Democratic candidate, and more 
saturated blues indicate increasing advantages for the Republican candidate.  
 

G98AGR_D 
Crawford 

This theme depicts difference between the percentage of votes 
cast for Bob Crawford for Commissioner of Agriculture in the 
1998 General Election, and the percentage of votes cast for 
Rich Faircloth.  

G98AGR_R 
Faircloth 

This theme depicts difference between the percentage of votes 
cast for Rich Faircloth for Commissioner of Agriculture in the 
1998 General Election, and the percentage of votes cast for Bob 
Crawford. 
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G98ATG_D 
Butterworth 

This theme depicts difference between the percentage of votes 
cast for Bob Butterworth for Attorney General in the 1998 
General Election, and the percentage of votes cast for David 
Bludworth. 

G98ATG_R 
Bludworth 

This theme depicts difference between the percentage of votes 
cast for David Bludworth for Attorney General in the 1998 
General Election, and the percentage of votes cast for Bob 
Butterworth. 

G98CMP_D 
Daughtrey 

This theme depicts difference between the percentage of votes 
cast for Newall Daughtrey for Comptroller in the 1998 General 
Election, and the percentage of votes cast for Bob Milligan. 

G98CMP_R Milligan This theme depicts difference between the percentage of votes 
cast for Bob Milligan for Comptroller in the 1998 General 
Election, and the percentage of votes cast for Newall Daughtrey. 

G98EDR_D Wallace This theme depicts difference between the percentage of votes 
cast for Peter Wallace for Commissioner of Education in the 
1998 General Election, and the percentage of votes cast for 
Tom Gallagher. 

G98EDU_R 
Gallagher 

This theme depicts difference between the percentage of votes 
cast for Tom Gallagher for Commissioner of Education in the 
1998 General Election, and the percentage of votes cast for 
Peter Wallace. 

G98SEC_D Gievers This theme depicts difference between the percentage of votes 
cast for Karen Gievers for Secretary of State in the 1998 
General Election, and the percentage of votes cast for Katherine 
Harris. 

G98SEC_R Harris This theme depicts difference between the percentage of votes 
cast for Katherine Harris for Secretary of State in the 1998 
General Election, and the percentage of votes cast for Karen 
Gievers. 

G98TRE_D Nelson This theme depicts difference between the percentage of votes 
cast for Bill Nelson for Treasurer in the 1998 General Election, 
and the percentage of votes cast for Tim Ireland. 
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G98TRE_R Ireland This theme depicts difference between the percentage of votes 
cast for Tim Ireland for Treasurer in the 1998 General Election, 
and the percentage of votes cast for Bill Nelson. 

  
2000 Election Results 

These themes use shading to show party advantage in Presidential, United 
States Senate, United States Representative, State Senate, and State 
Representative races in 2000.  

For all elections themes, data are depicted at the precinct level, more saturated 
reds indicate increasing advantages for the Democratic candidate, and more 
saturated blues indicate increasing advantages for the Republican candidate.  

For the composites, in cases where a precinct is in more than one district, votes 
for all candidates of the same party are added together.  
 

G00PRE_D Gore This theme depicts the percentage of votes cast for Al Gore in 
the 2000 General Election, relative to total votes cast for 
President. 

G00PRE_R Bush This theme depicts the percentage of votes cast for George W. 
Bush in the 2000 General Election, relative to total votes cast for 
President. 

G00PRE_G_Nader This theme depicts the percentage of votes cast for Ralph Nader 
in the 2000 General Election, relative to total votes cast for 
President. More saturated greens indicate increasing 
percentages for Nader. 

G00PRE_Others This theme depicts the percentage of votes cast for Presidential 
candidates other than George W. Bush, Al Gore, and Ralph 
Nader in the 2000 General Election, relative to total votes cast 
for President. Votes for Harry Browne (LIB), James Harris 
(SWP), John Hagelin (LAW), Pat Buchanan (REF), David 
McReynolds (SPF), Howard Phillips (CPF), Monica Moorehead 
(WWF), and all write-in candidates (WRI) are aggregated 
together. More saturated greens indicate increasing percentages 
for these other candidates. 
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G00STR_D 
Composite 

This theme depicts difference between the percentage of votes 
cast for Democratic candidates for State Representative in the 
2000 General Election, and the percentage of votes cast for 
Republican candidates.  

G00STR_R 
Composite 

This theme depicts difference between the percentage of votes 
cast for Republican candidates for State Representative in the 
2000 General Election, and the percentage of votes cast for 
Democratic candidates.  

G00STS_D 
Composite 

This theme depicts difference between the percentage of votes 
cast for Democratic candidates for State Senate in the 2000 
General Election, and the percentage of votes cast for 
Republican candidates.  

G00STS_R 
Composite 

This theme depicts difference between the percentage of votes 
cast for Republican candidates for State Senate in the 2000 
General Election, and the percentage of votes cast for 
Democratic candidates.  

G00USR_D 
Composite 

This theme depicts difference between the percentage of votes 
cast for Democratic candidates for United States Representative 
in the 2000 General Election, and the percentage of votes cast 
for Republican candidates.  

G00USR_R 
Composite 

This theme depicts difference between the percentage of votes 
cast for Republican candidates for United States Representative 
in the 2000 General Election, and the percentage of votes cast 
for Democratic candidates.  

G00USS_D Nelson This theme depicts difference between the percentage of votes 
cast for Bill Nelson for United States Senate in the 2000 General 
Election, and the percentage of votes cast for Bill McCollum. 

G00USS_R 
McCollum 

This theme depicts difference between the percentage of votes 
cast for Bill McCollum for United States Senate in the 2000 
General Election, and the percentage of votes cast for Bill 
Nelson. 
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2000 Election Results--More Statewide Elections 

These themes use shading to depict the results of statewide General Election 
contests in 2000 for cabinet offices and of the Democratic Primary contest in 
2000 for Commissioner of Education.   

For all elections themes, data are depicted at the precinct level, more saturated 
reds indicate increasing advantages for the Democratic candidate, and more 
saturated blues indicate increasing advantages for the Republican candidate.  
 

G00EDU_D 
Sheldon 

This theme depicts difference between the percentage of votes 
cast for George Sheldon for Commissioner of Education in the 
2000 General Election, and the percentage of votes cast for 
Charlie Crist. 

G00EDU_R Crist This theme depicts difference between the percentage of votes 
cast for Charlie Crist for Commissioner of Education in the 2000 
General Election, and the percentage of votes cast for George 
Sheldon. 

G00TRE_D 
Cosgrove 

This theme depicts difference between the percentage of votes 
cast for John Cosgrove for Treasurer in the 2000 General 
Election, and the percentage of votes cast for Tom Gallagher. 

G00TRE_R 
Gallagher 

This theme depicts difference between the percentage of votes 
cast for Tom Gallagher for Treasurer in the 2000 General 
Election, and the percentage of votes cast for John Cosgrove. 

P00EDU Bush This theme depicts the difference in the percentage of votes cast 
for James Bush for Commissioner of Education in the 2000 
Democratic Primary Election, and the percentage of votes cast 
for George Sheldon. 
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Precinct Boundaries 

These themes depict the boundaries of voting precincts for different elections. At 
a statewide view, precinct lines are not visible. At a regional level or below, dark 
green lines appear. At local map extents, the boundary lines are supplemented 
with dark green precinct labels.  

Precinct boundaries were not derived from the Census TIGER/Line files. They 
were digitized soon after each election based on precinct maps collected from 
supervisors of elections. Some precinct boundaries do not line up exactly with 
census block boundaries. This may be because the precinct boundary truly splits 
a Census 2000 block, or it may occur because the base geography used for 
building the precinct boundaries is slightly different than the Census TIGER/Line 
files for 2000.  

Actual precinct boundaries are not available for building districts. A similar layer 
in the "Geography\Census Lines" folder, called "Precinct Proxies" can be used 
for building districts.  
 

Precinct 00 This theme displays the outlines of the precincts in effect for the elections 
in 2000. 

Precinct 92 This theme displays the outlines of the precincts in effect for the elections 
in 1992 

Precinct 94 This theme displays the outlines of the precincts in effect for the elections 
in 1994. 

Precinct 96 This theme displays the outlines of the precincts in effect for the elections 
in 1996. 

Precinct 98 This theme displays the outlines of the precincts in effect for the elections 
in 1998. 
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Voter Registration 

1992 Voter Registration 

These themes use shading to depict registered voters by party in 1992. 

For all voter registration themes, data are depicted at the precinct level, more 
saturated reds indicate increasing Democratic advantages, and more saturated 
blues indicate increasing Republican advantages. 
 

RV92_DemAdv This theme depicts difference between the percentage of 
registered Democrats and the percentage of registered 
Republicans, relative to all registered voters at book closing for 
the 1992 General Election.  

RV92_DemMajority This theme shows whether either of the major parties has a 
majority of the registered voters in a precinct. Democratic 
majorities are depicted in reds, and Republican majorities are 
depicted in blues. If Democrats have a majority, the value for this 
theme is the percentage of Democrats. If Republicans have a 
majority, the value for this theme is 100% minus the percentage 
of Republicans. If neither party has more than 50% of all 
registered voters (including independents and minor parties), the 
value for this theme is 50%, and the precinct is not colored. 

RV92_RepAdv This theme depicts difference between the percentage of 
registered Republicans and the percentage of registered 
Democrats, relative to all registered voters at book closing for the 
1992 General Election. 

RV92_RepMajority This theme shows whether either of the major parties has a 
majority of the registered voters in a precinct. Republican 
majorities are depicted in blues, and Democratic majorities are 
depicted in reds. If Republicans have a majority, the value for this 
theme is the percentage of Republicans . If Democrats have a 
majority, the value for this theme is 100% minus the percentage 
of Democrats. If neither party has more than 50% of all registered 
voters (including independents and minor parties), the value for 
this theme is 50%, and the precinct is not colored. 

. 
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1992 Voter Registration--By Race and Party 

These themes use shading to depict percentages in 1992 of black and Hispanic 
registered voters in the electorate and broken down by party. See Legends for 
visual breakouts. 
 

RV92 BlackHisp (15pct 
increments) 

This theme classifies registered voters in a 2-
dimensional scheme according to percentages of 
Hispanic voters and percentages of black 
(African-American) voters, as of book closing for 
the 1992 General Election. More saturated blues 
indicate higher percentages of Hispanic voters. 
More saturated reds indicate higher percentages 
of black voters. Purples indicate concentrations of 
both Hispanics and blacks in the same area. 
Class breaks occur in increments of 15%, 
beginning at zero. Data are displayed at precinct 
level. 

RV92 BlackHisp (5pct increments) This theme is like "RV92 BlackHisp (15pct 
increments)," except class breaks occur in 
increments of 5%, beginning at zero. 

RV92_Dem BlackHisp (15pct 
increments) 

This theme is like "RV92 BlackHisp (15pct 
increments)," except the population classified is 
limited to registered Democrats. 

RV92_Dem BlackHisp (5pct 
increments) 

This theme is like "RV92_Dem BlackHisp (15pct 
increments)," except class breaks occur in 
increments of 5%, beginning at zero. 

RV92_Rep BlackHisp (15pct 
increments) 

This theme is like "RV92 BlackHisp (15pct 
increments)," except the population classified is 
limited to registered Republicans. 

RV92_Rep BlackHisp (5pct 
increments) 

This theme is like "RV92_Rep BlackHisp (15pct 
increments)," except class breaks occur in 
increments of 5%, beginning at zero. 
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1994 Voter Registration 

These themes use shading to depict registered voters by party in 1994. 

For all voter registration themes, data are depicted at the precinct level, more 
saturated reds indicate increasing Democratic advantages, and more saturated 
blues indicate increasing Republican advantages. 
 

RV94_DemAdv This theme depicts difference between the percentage of 
registered Democrats and the percentage of registered 
Republicans, relative to all registered voters at book closing for 
the 1994 General Election.  

RV94_DemMajority This theme shows whether either of the major parties has a 
majority of the registered voters in a precinct. Democratic 
majorities are depicted in reds, and Republican majorities are 
depicted in blues. If Democrats have a majority, the value for 
this theme is the percentage of Democrats. If Republicans have 
a majority, the value for this theme is 100% minus the 
percentage of Republicans. If neither party has more than 50% 
of all registered voters (including independents and minor 
parties), the value for this theme is 50%, and the precinct is not 
colored. 

RV94_RepAdv This theme depicts difference between the percentage of 
registered Republicans and the percentage of registered 
Democrats, relative to all registered voters at book closing for 
the 1994 General Election. 

RV94_RepMajority This theme shows whether either of the major parties has a 
majority of the registered voters in a precinct. Republican 
majorities are depicted in blues, and Democratic majorities are 
depicted in reds. If Republicans have a majority, the value for 
this theme is the percentage of Republicans . If Democrats 
have a majority, the value for this theme is 100% minus the 
percentage of Democrats. If neither party has more than 50% 
of all registered voters (including independents and minor 
parties), the value for this theme is 50%, and the precinct is not 
colored. 
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1994 Voter Registration--By Race and Party 

These themes use shading to depict percentages in 1994 of  black and Hispanic 
registered voters in the electorate and broken down by party. See Legends for 
visual breakouts. 
 

RV94 BlackHisp (15 pct 
increments) 

This theme classifies registered voters in a 2-
dimensional scheme according to percentages of 
Hispanic voters and percentages of black (African-
American) voters, as of book closing for the 1994 
General Election. More saturated blues indicate 
higher percentages of Hispanic voters. More 
saturated reds indicate higher percentages of 
black voters. Purples indicate concentrations of 
both Hispanics and blacks in the same area. Class 
breaks occur in increments of 15%, beginning at 
zero. Data are displayed at precinct level. 

RV94 BlackHisp (5 pct 
increments) 

This theme is like "RV94 BlackHisp (15pct 
increments)," except class breaks occur in 
increments of 5%, beginning at zero. 

RV94_Dem BlackHisp (15 pct 
increments) 

This theme is like "RV94 BlackHisp (15pct 
increments)," except the population classified is 
limited to registered Democrats. 

RV94_Dem BlackHisp (5 pct 
increments) 

This theme is like "RV94_Dem BlackHisp (15pct 
increments)," except class breaks occur in 
increments of 5%, beginning at zero. 

RV94_Rep BlackHisp (15 pct 
increments) 

This theme is like "RV94 BlackHisp (15pct 
increments)," except the population classified is 
limited to registered Republicans. 

Rv94_Rep BlackHisp (5 pct 
increments) 

This theme is like "RV94_Rep BlackHisp (15pct 
increments)," except class breaks occur in 
increments of 5%, beginning at zero. 
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1996 Voter Registration 

These themes use shading to depict registered voters by party in 1996. 

For all voter registration themes, data are depicted at the precinct level, more 
saturated reds indicate increasing Democratic advantages, and more saturated 
blues indicate increasing Republican advantages. 
 

RV96_DemAdv This theme depicts difference between the percentage of 
registered Democrats and the percentage of registered 
Republicans, relative to all registered voters at book closing for 
the 1996 General Election.  

RV96_DemMajority This theme shows whether either of the major parties has a 
majority of the registered voters in a precinct. Democratic 
majorities are depicted in reds, and Republican majorities are 
depicted in blues. If Democrats have a majority, the value for 
this theme is the percentage of Democrats. If Republicans have 
a majority, the value for this theme is 100% minus the 
percentage of Republicans. If neither party has more than 50% 
of all registered voters (including independents and minor 
parties), the value for this theme is 50%, and the precinct is not 
colored. 

RV96_RepAdv This theme depicts difference between the percentage of 
registered Republicans and the percentage of registered 
Democrats, relative to all registered voters at book closing for 
the 1996 General Election. 

RV96_RepMajority This theme shows whether either of the major parties has a 
majority of the registered voters in a precinct. Republican 
majorities are depicted in blues, and Democratic majorities are 
depicted in reds. If Republicans have a majority, the value for 
this theme is the percentage of Republicans . If Democrats have 
a majority, the value for this theme is 100% minus the 
percentage of Democrats. If neither party has more than 50% of 
all registered voters (including independents and minor parties), 
the value for this theme is 50%, and the precinct is not colored. 
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1996 Voter Registration--by Race and party 

These themes use shading to depict percentages in 1996 of  black and Hispanic 
registered voters in the electorate and broken down by party. See Legends for 
visual breakouts. 
 

RV96 BlackHisp (15pct 
increments) 

This theme classifies registered voters in a 2-
dimensional scheme according to percentages of 
Hispanic voters and percentages of black (African-
American) voters, as of book closing for the 1996 
General Election. More saturated blues indicate 
higher percentages of Hispanic voters. More 
saturated reds indicate higher percentages of 
black voters. Purples indicate concentrations of 
both Hispanics and blacks in the same area. Class 
breaks occur in increments of 15%, beginning at 
zero. Data are displayed at precinct level. 

RV96 BlackHisp (5 pct 
increments) 

This theme is like "RV96 BlackHisp (15pct 
increments)," except class breaks occur in 
increments of 5%, beginning at zero. 

RV96_Dem BlackHisp (15 pct 
increments) 

This theme is like "RV96 BlackHisp (15pct 
increments)," except the population classified is 
limited to registered Democrats. 

RV96_Dem BlackHisp (5 pct 
increments) 

This theme is like "RV96_Dem BlackHisp (15pct 
increments)," except class breaks occur in 
increments of 5%, beginning at zero. 

RV96_Rep BlackHisp (15 pct 
increments) 

This theme is like "RV96 BlackHisp (15pct 
increments)," except the population classified is 
limited to registered Republicans. 

RV96_Rep BlackHisp (5 pct 
increments) 

This theme is like "RV96_Rep BlackHisp (15pct 
increments)," except class breaks occur in 
increments of 5%, beginning at zero. 
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1998 Voter Registration 

These themes use shading to depict registered voters by party in 1998. 

For all voter registration themes, data are depicted at the precinct level, more 
saturated reds indicate increasing Democratic advantages, and more saturated 
blues indicate increasing Republican advantages. 
 

RV98_DemAdv This theme depicts difference between the percentage of 
registered Democrats and the percentage of registered 
Republicans, relative to all registered voters at book closing 
for the 1998 General Election.  

RV98_DemMajority This theme shows whether either of the major parties has a 
majority of the registered voters in a precinct. Democratic 
majorities are depicted in reds, and Republican majorities are 
depicted in blues. If Democrats have a majority, the value for 
this theme is the percentage of Democrats. If Republicans 
have a majority, the value for this theme is 100% minus the 
percentage of Republicans. If neither party has more than 
50% of all registered voters (including independents and 
minor parties), the value for this theme is 50%, and the 
precinct is not colored. 

RV98_RepAdv This theme depicts difference between the percentage of 
registered Republicans and the percentage of registered 
Democrats, relative to all registered voters at book closing for 
the 1998 General Election. 

RV98_RepMajority This theme shows whether either of the major parties has a 
majority of the registered voters in a precinct. Republican 
majorities are depicted in blues, and Democratic majorities 
are depicted in reds. If Republicans have a majority, the value 
for this theme is the percentage of Republicans . If Democrats 
have a majority, the value for this theme is 100% minus the 
percentage of Democrats. If neither party has more than 50% 
of all registered voters (including independents and minor 
parties), the value for this theme is 50%, and the precinct is 
not colored. 
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1998 Voter Registration--By Race and Party 

These themes use shading to depict percentages in 1998 of  black and Hispanic 
registered voters in the electorate and broken down by party. See Legends for 
visual breakouts. 
 

RV98 BlackHisp (15pct 
increments) 

This theme classifies registered voters in a 2-
dimensional scheme according to percentages of 
Hispanic voters and percentages of black 
(African-American) voters, as of book closing for 
the 1998 General Election. More saturated blues 
indicate higher percentages of Hispanic voters. 
More saturated reds indicate higher percentages 
of black voters. Purples indicate concentrations of 
both Hispanics and blacks in the same area. 
Class breaks occur in increments of 15%, 
beginning at zero. Data are displayed at precinct 
level. 

RV98 BlackHisp (5pct increments) This theme is like "RV98 BlackHisp (15pct 
increments)," except class breaks occur in 
increments of 5%, beginning at zero. 

RV98_Dem BlackHisp (15pct 
increments) 

This theme is like "RV98 BlackHisp (15pct 
increments)," except the population classified is 
limited to registered Democrats. 

RV98_Dem BlackHisp (5pct 
increments) 

This theme is like "RV98_Dem BlackHisp (15pct 
increments)," except class breaks occur in 
increments of 5%, beginning at zero. 

RV98_Rep BlackHisp (15pct 
increments) 

This theme is like "RV98 BlackHisp (15pct 
increments)," except the population classified is 
limited to registered Republicans. 

RV98_Rep BlackHisp (5pct 
increments) 

This theme is like "RV98_Rep BlackHisp (15pct 
increments)," except class breaks occur in 
increments of 5%, beginning at zero. 
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1998 Voter Registration--Party Advantage By Age 

These themes use shading to depict percentages of registered voters by party in 
particular age groups in 1998.  

For all voter registration themes, data are depicted at the precinct level, more 
saturated reds indicate increasing Democratic advantages, and more saturated 
blues indicate increasing Republican advantages.  
 

RV98_DemAdv 18 to 29 
years 

This theme depicts difference among voters 18 to 29 
years old between the percentage of registered 
Democrats and the percentage of registered 
Republicans (book closing for the 1998 General 
Election).  

RV98_DemAdv 30 to 44 
years 

This theme depicts difference among voters 30 to 44 
years old between the percentage of registered 
Democrats and the percentage of registered 
Republicans (book closing for the 1998 General 
Election). 

RV98_DemAdv 45 to 54 
years 

This theme depicts difference among voters 45 to 54 
years old between the percentage of registered 
Democrats and the percentage of registered 
Republicans (book closing for the 1998 General 
Election). 

RV98_DemAdv 55 to 64 
years 

This theme depicts difference among voters 55 to 64 
years old between the percentage of registered 
Democrats and the percentage of registered 
Republicans (book closing for the 1998 General 
Election). 

RV98_DemAdv 65 years 
and over 

This theme depicts difference among voters 65 years 
and older between the percentage of registered 
Democrats and the percentage of registered 
Republicans (book closing for the 1998 General 
Election). 

RV98_RepADV 18 to 29 
years 

This theme depicts difference among voters 18 to 29 
years old between the percentage of registered 
Republicans and the percentage of registered 
Democrats (book closing for the 1998 General Election). 
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RV98_RepADV 30 to 44 
years 

This theme depicts difference among voters 30 to 44 
years old between the percentage of registered 
Republicans and the percentage of registered 
Democrats (book closing for the 1998 General Election). 

RV98_RepADV 45 to 54 
years 

This theme depicts difference among voters 45 to 54 
years old between the percentage of registered 
Republicans and the percentage of registered 
Democrats (book closing for the 1998 General Election). 

RV98_RepADV 55 to 64 
years 

This theme depicts difference among voters 55 to 64 
years old between the percentage of registered 
Republicans and the percentage of registered 
Democrats (book closing for the 1998 General Election). 

RV98_RepADV 65 years 
and older 

This theme depicts difference among voters 65 years 
and older between the percentage of registered 
Republicans and the percentage of registered 
Democrats (book closing for the 1998 General Election). 
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1998 Voter Registration--Party Advantage By Gender 

These themes use shading to depict percentages of registered voters by party 
among males and females in 1998.  

For all voter registration themes, data are depicted at the precinct level, more 
saturated reds indicate increasing Democratic advantages, and more saturated 
blues indicate increasing Republican advantages.  
 

RV98_DemAdv 
Female 

This theme depicts difference among female voters between the 
percentage of registered Democrats and the percentage of 
registered Republicans (book closing for the 1998 General 
Election). For all voter registration themes, data are depicted at 
the precinct level, more saturated reds indicate increasing 
Democratic advantages, and more saturated blues indicate 
increasing Republican advantages. 

RV98_DemAdv 
Male 

This theme depicts difference among male voters between the 
percentage of registered Democrats and the percentage of 
registered Republicans (book closing for the 1998 General 
Election). 

RV98_RepAdv 
Female 

This theme depicts difference among female voters between the 
percentage of registered Republicans and the percentage of 
registered Democrats (book closing for the 1998 General 
Election). 

RV98_RepAdv 
Male 

This theme depicts difference among male voters between the 
percentage of registered Republicans and the percentage of 
registered Democrats (book closing for the 1998 General 
Election). 
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2000 Voter Registration 

These themes use shading to depict registered voters by party in 2000. 

For all voter registration themes, data are depicted at the precinct level, more 
saturated reds indicate increasing Democratic advantages, and more saturated 
blues indicate increasing Republican advantages. 
 

RV00_Dem Advantage This theme depicts difference between the percentage of 
registered Democrats and the percentage of registered 
Republicans, relative to all registered voters at book 
closing for the 2000 General Election.  

RV00_Dem Majority This theme shows whether either of the major parties 
has a majority of the registered voters in a precinct. 
Democratic majorities are depicted in reds, and 
Republican majorities are depicted in blues. If Democrats 
have a majority, the value for this theme is the 
percentage of Democrats. If Republicans have a 
majority, the value for this theme is 100% minus the 
percentage of Republicans. If neither party has more 
than 50% of all registered voters (including independents 
and minor parties), the value for this theme is 50%, and 
the precinct is not colored. 

RV00_Rep Advantage This theme depicts difference between the percentage of 
registered Republicans and the percentage of registered 
Democrats, relative to all registered voters at book 
closing for the 2000 General Election. 

RV00_Rep Majority This theme shows whether either of the major parties 
has a majority of the registered voters in a precinct. 
Republican majorities are depicted in blues, and 
Democratic majorities are depicted in reds. If 
Republicans have a majority, the value for this theme is 
the percentage of Republicans . If Democrats have a 
majority, the value for this theme is 100% minus the 
percentage of Democrats. If neither party has more than 
50% of all registered voters (including independents and 
minor parties), the value for this theme is 50%, and the 
precinct is not colored. 
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2000 Voter Registration--By Race and Party 

These themes use shading to depict percentages in 2000 of  black and Hispanic 
registered voters in the electorate and broken down by party. See Legends for 
visual breakouts. 
 

RV00 BlackHisp (15pct 
increments) 

This theme classifies registered voters in a 2-
dimensional scheme according to percentages of 
Hispanic voters and percentages of black 
(African-American) voters, as of book closing for 
the 2000 General Election. More saturated blues 
indicate higher percentages of Hispanic voters. 
More saturated reds indicate higher percentages 
of black voters. Purples indicate concentrations of 
both Hispanics and blacks in the same area. 
Class breaks occur in increments of 15%, 
beginning at zero. Data are displayed at precinct 
level. 

RV00 BlackHisp (5pct increments) This theme is like "RV00 BlackHisp (15pct 
increments)," except class breaks occur in 
increments of 5%, beginning at zero. 

RV00_Dem BlackHisp (15pct 
increments) 

This theme is like "RV00 BlackHisp (15pct 
increments)," except the population classified is 
limited to registered Democrats. 

RV00_Dem BlackHisp (5pct 
increments) 

This theme is like "RV00_Dem BlackHisp (15pct 
increments)," except class breaks occur in 
increments of 5%, beginning at zero. 

RV00_Rep BlackHisp (15pct 
increments) 

This theme is like "RV00 BlackHisp (15pct 
increments)," except the population classified is 
limited to registered Republicans. 

RV00_Rep BlackHisp (5pct 
increments) 

This theme is like "RV00_Rep BlackHisp (15pct 
increments)," except class breaks occur in 
increments of 5%, beginning at zero. 
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2000 Voter Registration--Party Advantage By Age 

These themes use shading to depict percentages of registered voters by party in 
particular age groups in 2000.  

For all voter registration themes, data are depicted at the precinct level, more 
saturated reds indicate increasing Democratic advantages, and more saturated 
blues indicate increasing Republican advantages.  
 

RV00_DemAdv 18 to 29 
years 

This theme depicts difference among voters 18 to 29 
years old between the percentage of registered 
Democrats and the percentage of registered 
Republicans (book closing for the 2000 General 
Election).  

RV00_DemAdv 30 to 44 
years 

This theme depicts difference among voters 30 to 44 
years old between the percentage of registered 
Democrats and the percentage of registered 
Republicans (book closing for the 2000 General 
Election). 

RV00_DemAdv 45 to 54 
years 

This theme depicts difference among voters 45 to 54 
years old between the percentage of registered 
Democrats and the percentage of registered 
Republicans (book closing for the 2000 General 
Election). 

RV00_DemAdv 55 to 64 
years 

This theme depicts difference among voters 55 to 64 
years old between the percentage of registered 
Democrats and the percentage of registered 
Republicans (book closing for the 2000 General 
Election). 

RV00_DemAdv 65 years and 
over 

This theme depicts difference among voters 65 years 
and older between the percentage of registered 
Democrats and the percentage of registered 
Republicans (book closing for the 2000 General 
Election). 

RV00_RepAdv 18 to 29 
years 

This theme depicts difference among voters 18 to 29 
years old between the percentage of registered 
Republicans and the percentage of registered 
Democrats (book closing for the 2000 General 
Election). 
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RV00_DemAdv 30 to 44 
years 

This theme depicts difference among voters 30 to 44 
years old between the percentage of registered 
Republicans and the percentage of registered 
Democrats (book closing for the 2000 General 
Election). 

RV00_DemAdv 45 to 54 
years 

This theme depicts difference among voters 45 to 54 
years old between the percentage of registered 
Republicans and the percentage of registered 
Democrats (book closing for the 2000 General 
Election). 

RV00_DemAdv 55 to 64 
years 

This theme depicts difference among voters 55 to 64 
years old between the percentage of registered 
Republicans and the percentage of registered 
Democrats (book closing for the 2000 General 
Election). 

RV00_DemAdv 65 years and 
over 

This theme depicts difference among voters 65 years 
and older between the percentage of registered 
Republicans and the percentage of registered 
Democrats (book closing for the 2000 General 
Election). 
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2000 Voter Registration--Party Advantage By Gender 

These themes use shading to depict percentages of registered voters by party 
among males and females in 2000.  

For all voter registration themes, data are depicted at the precinct level, more 
saturated reds indicate increasing Democratic advantages, and more saturated 
blues indicate increasing Republican advantages.  
 

RV00_DemAdv 
Female 

This theme depicts difference among female voters between the 
percentage of registered Democrats and the percentage of 
registered Republicans (book closing for the 2000 General 
Election).  

RV00_DemAdv 
Male 

This theme depicts difference among male voters between the 
percentage of registered Democrats and the percentage of 
registered Republicans (book closing for the 2000 General 
Election). 

RV00_RepAdv 
Female 

This theme depicts difference among female voters between the 
percentage of registered Republicans and the percentage of 
registered Democrats (book closing for the 2000 General 
Election). 

RV00_RepAdv 
Male 

This theme depicts difference among male voters between the 
percentage of registered Republicans and the percentage of 
registered Democrats (book closing for the 2000 General 
Election). 
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Geography 
Census Lines 

The six "Census Lines" themes correspond to the six levels of geography 
available for building plans. Counties, tracts, block groups, and blocks form 
hierarchy of census geography. Precinct proxies are approximations of voting 
precincts, made from blocks, block groups and tracts. Cities and places are 
designated by the Census as population centers that are also composed from 
blocks, block groups, and tracts.  
Making lines visible at the current assignment level allows you to see what areas 
will be added to districts before making assignments. That is, if you are building 
at block group level, The block group theme should be checked on.  
 

Block Lines This theme displays the boundaries of census blocks. There are 
362,499 blocks in the state, making block boundaries, for the most 
part, indistinguishable at anything but local level map extents. At 
wider map extents, block boundaries are hidden from view. At a 
local level, block lines appear in gray, distinguishing them from 
block group lines (which appear as black lines) and tract lines 
(which appear as bold black lines) 

Block Group Lines This theme displays the boundaries of census block groups. 
There are 9,112 block groups in the state. The appearance of 
block group lines varies depending on the scale of the map. At a 
statewide or regional view, block group lines are not visible. At a 
county level, gray block group lines appear. At a local level, block 
group lines appear in black, distinguishing them from tract lines 
(which then appear as bold black lines) and block lines (which 
then appear as gray lines).  

Tract Lines This theme displays the boundaries of census tracts.  There are 
3,154 census tracts in the state. There are The appearance of 
tract lines varies depending on the scale of the map. At a 
statewide view, tract lines are not visible. At a regional or county 
view, tract lines appear as dark black lines, distinguishable from 
the heavy dashed county lines and gray block group lines. At a 
local level, block group lines appear in bold black, distinguishing 
them from block group lines (which appear in normal weight black) 
and block lines (which appear in gray). 

County Lines This theme displays county boundaries of all 67 counties in the 
state. County boundaries appear as dashed black line and are 
visible at all levels of zoom. At more focused map extents, county 
lines are bolder. 
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Precinct Proxy 
Lines 

This theme displays the outlines of the precinct proxies, which are 
approximations of precinct boundaries for the 2000 elections 
constructed from census blocks. Where voting precinct 
boundaries do not align with census block boundaries, the 
precinct proxy will not match the official precinct boundaries set by 
the county. Using precinct proxies for building districts may reduce 
the number of voting precincts split into multiple districts.  

Precinct proxy boundaries appear as dark green lines at regional 
map extents and below. They are different than the precinct 
boundary themes for 1992 through 2000 in the "Elections\Precinct 
Boundaries," which depict actual precinct boundaries but do not 
follow census geography and are not available for building 
districts. 

Cities and Places This theme has different appearances depending on the scale of 
the map. At statewide and regional map extents, just name labels 
appear. At county and local map extents, municipal boundaries 
appear as light gray lines, and areas within municipalities are 
indicated with a light gray crosshatch pattern. When adding 
territory to districts at the "Municipality" level of geography, all 
areas inside the outer boundary of the municipality will be added 
to the active district. 

 

City and County Names 

These themes use labels on the map to display the names of cities and counties. 
 

City Names This theme displays the names of municipalities. It also shows the 
names of unincorporated areas that are "census designated places." 
Names for the most populous places are visible at a statewide map 
extent. At more focused map extents, more names become visible. 
Place boundaries are depicted in another theme, called "Cities and 
Places" in the "\Geography\Census Lines" folder. 

County 
Names 

This theme displays the names of all 67 counties in the state. 
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Plans of Record 

These themes depict State Senate, State Representative, and United States 
Representative district boundaries in bold, dark blue. At regional map extents 
and below, dark blue district numbers also appear.  

These "Plans of Record" themes are helpful companions to the "Composite" 
themes in the "Elections\Election Results" folders.  
 

1992 House Districts This theme displays Florida House of Representatives 
districts enacted by the Legislature and modified by federal 
court order in 1992 (Plan 352). These districts were in effect 
for elections of 1992 through 2000. 

1992-95 Congress 
Districts 

This theme displays Florida congressional districts adopted by 
federal court order in 1992 (Plan 309). These districts were in 
effect for the elections of 1992 and 1994.  

1992-95 Senate 
Districts 

This theme displays Florida Senate districts enacted by the 
Legislature and modified by Florida Supreme Court order in 
1992 (Plan 330). These districts were in effect for the 
elections of 1992 and 1994.  

1996 Congress 
Districts 

This theme displays Florida congressional districts enacted by 
the Legislature in 1996 (Plan 412). These districts were in 
effect for the elections of 1996, 1998, and 2000.  

1996 Senate Districts This theme displays Florida Senate districts adopted by 
federal court order in 1996 (Plan 386). These districts were in 
effect for the elections of 1996, 1998, and 2000.  
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Streets 

These themes depict streets, highways, and ZIP codes with lines and labels on 
the map.  
 

Highways This theme depicts arterial roads and expressways. It is 
similar to the "Streets and Highways" theme, except local 
roads are not shown. This theme provides useful orientation 
information without carrying the full load of all street features 
and annotations. 

Streets and Highways This theme depicts lines designated as street features in the 
Census TIGER/Line files. The theme appears differently at 
different map scales. At neighborhood map extents, all streets 
appear as red lines and are annotated with red name labels, 
arterial roads appear as bold red lines, and expressways 
appear as bold red lines with black outlines. At local map 
extents, the symbology is the same, but only arterial roads 
and expressways are labeled. At county and regional map 
extents, local streets disappear, and the weight of arterial 
roads and expressways are reduced. At statewide map 
extents, only expressways appear as red lines, annotated with 
red name labels.  

Zip Code Tabulation 
Areas 

This theme displays the approximate territories bounded by 
particular 5-digit zip codes. At a statewide or regional view, 
these boundaries are not visible. At a county level or below, 
dark blue boundary lines and the 5-digit zip code appear. In 
areas where only the first 3 digits of a zip code are known, the 
last 2 digits are filled with "XX." For some large bodies of 
water, the last two digits are filled with "HH." 
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Water 

These themes use gray fill and dark blue lines to depict water bodies, streams, 
canals, lakes, rivers, and shorelines. 
 

All Waters This theme depicts areas designated as water bodies in the 
Census TIGER/Line files. The theme appears differently 
depending on the scale of the map. At county and local map 
extents, all waters appear in transparent dark gray fill (making it 
possible to see district or thematic information as well as the 
water features). At statewide and regional map extents, only 
coastal waters appear. 

Coastal Waters This theme depicts coastal waters in transparent dark gray fill 
(making it possible to see district or thematic information as well 
as the water features). It is similar to the "All Waters" theme, but 
most interior lakes are missing. 

Shoreline This theme displays the lines that bound coastal waters in dark 
blue.  

Streams and 
Shores 

This theme depicts lines designated as hydrographic features in 
the Census TIGER/Line files. At county and local map extents, all 
hydrographic features appear as dark blue lines. At statewide and 
regional map extents, only shoreline features appear. 
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Population 

1990 Census 

These themes are labels indicating counts for total population and voting age 
population based on 1990 Census data.  

For all population label themes, data are displayed for different levels of census 
geography depending on the scale of the map. At the statewide map extent, no 
labels appear. At a regional level, labels for entire counties appear. At a local or 
county level, labels for tracts appear. At a neighborhood level, labels for 
individual blocks appear. Labels are placed at the geometric center of a unit of 
geography, which in some cases is outside its boundaries.  
 

TPop90 Counts  This theme puts labels on the map showing counts of total 
population determined by the 1990 Census.  

TVAP90 Counts This theme labels the map with counts of total voting age 
population (18 years of age and older) determined by the 
1990 Census. 

  

1990 Census--More Count Labels 

These themes are labels indicating counts in the 1990 Census for total 
population and voting age population, broken down by race and ethnicity. 

For all population label themes, data are displayed for different levels of census 
geography depending on the scale of the map. At the statewide map extent, no 
labels appear. At a regional level, labels for entire counties appear. At a local or 
county level, labels for tracts appear. At a neighborhood level, labels for 
individual blocks appear. Labels are placed at the geometric center of a unit of 
geography, which in some cases is outside its boundaries.  
 

HBPop90 Counts This theme puts labels on the map showing counts of Hispanic 
black persons (i.e., persons of Hispanic origin who also identified 
themselves as black or African-American), as determined by the 
1990 Census.  
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HBVAP90 Counts This theme labels the map with counts of Hispanic black voting age 
persons (i.e., persons of Hispanic origin who also identified 
themselves as black or African-American who are age 18 and 
over), as determined by the 1990 Census. 

HxBPop90 
Counts 

This theme labels the map with counts of persons of Hispanic 
origin, excluding Hispanic blacks, as determined by the 1990 
Census. 

HxBVAP90 
Counts 

This theme labels the map with counts of persons of Hispanic 
origin who are 18 years of age and over, excluding Hispanic 
blacks, as determined by the 1990 Census. 

NHBPop90 
Counts 

This theme labels the map with counts of non-Hispanic black 
(African-American) persons, as determined by the 1990 Census. 

NHBVAP90 
Counts 

This theme labels the map with counts of non-Hispanic black 
(African-American) persons 18 years of age and over, as 
determined by the 1990 Census. 

NHOPop90 
Counts 

This theme labels the map with counts of non-Hispanic other 
persons (i.e., persons identifying themselves as Asian, Hawaiian, 
Native American, Pacific Islander, or Other who are not of Hispanic 
origin), as determined by the 1990 Census. 

NHOVAP90 
Counts 

This theme labels the map with counts of non-Hispanic other voting 
age persons (i.e., persons 18 years of age and over who are 
Asian, Hawaiian, Native American, Pacific Islander, or Other and 
who are not of Hispanic origin), as determined by the 1990 
Census. 

NHWPop90 
Counts 

This theme labels the map with counts of non-Hispanic white 
persons, as determined by the 1990 Census. 

NHWVAP90 
Counts 

This theme labels the map with counts of non-Hispanic white 
persons 18 years of age and over, as determined by the 1990 
Census. 
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1990 Census--Percentage Labels 

These themes are labels indicating population percentages in the 1990 Census, 
broken down by race and ethnicity. 

For all population label themes, data are displayed for different levels of census 
geography depending on the scale of the map. At the statewide map extent, no 
labels appear. At a regional level, labels for entire counties appear. At a local or 
county level, labels for tracts appear. At a neighborhood level, labels for 
individual blocks appear. Labels are placed at the geometric center of a unit of 
geography, which in some cases is outside its boundaries.  
 

HBPop90 
Percentages 

This theme puts labels on the map showing percentages of 
Hispanic black persons (i.e., persons of Hispanic origin who 
also identified themselves as black or African-American), 
relative to the total population, as determined by the 1990 
Census.  

HBVAP90 
Percentages 

This theme labels the map with percentages of Hispanic black 
voting age persons (i.e., persons of Hispanic origin who also 
identified themselves as black or African-American who are 18 
years of age and over), relative to the total voting age 
population, as determined by the 1990 Census. 

HxBPop90 
Percentages 

This theme labels the map with percentages of persons of 
Hispanic origin, excluding Hispanic blacks, relative to the total 
population, as determined by the 1990 Census. 

HxBVAP90 
Percentages 

This theme labels the map with percentages of persons of 
Hispanic origin who are 18 years of age and over, excluding 
Hispanic blacks, relative to the total voting age population, as 
determined by the 1990 Census. 

NHBPop90 
Percentages 

This theme labels the map with percentages of non-Hispanic 
black (African-American) persons, relative to the total 
population, as determined by the 1990 Census. 

NHBVAP90 
Percentages 

This theme labels the map with percentages of non-Hispanic 
black (African-American) persons 18 years of age and over, 
relative to the total voting age population, as determined by 
the 1990 Census. 
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NHOPop90 
Percentages 

This theme labels the map with percentages of non-Hispanic 
other persons (i.e., persons identifying themselves as Asian, 
Hawaiian, Native American, Pacific Islander, or Other who are 
not of Hispanic origin), relative to the total population, as 
determined by the 1990 Census. 

NHOVAP90 
Percentages 

This theme labels the map with percentages of non-Hispanic 
other voting age persons (i.e., persons 18 years of age and 
over who are Asian, Hawaiian, Native American, Pacific 
Islander, or Other and who are not of Hispanic origin), relative 
to the total voting age population, as determined by the 1990 
Census. 

NHWPop90 
Percentages 

This theme labels the map with percentages of non-Hispanic 
white persons, relative to the total population, as determined 
by the 1990 Census. 

NHWVAP90 
Percentages 

This theme labels the map with percentages of non-Hispanic 
white persons 18 years of age and over, relative to the total 
voting age population, as determined by the 1990 Census. 
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1990 Census--Shaded Themes 

These themes are based on the 1990 Census. They shade the map according to 
population density in the first theme and percentages of black and Hispanic 
voting age population in the other two themes. See Legends for visual breakouts. 
 

TPop90 Per Sq Mile (BlkGrp) This theme depicts the population density of block 
groups, measured in persons per square mile, as 
determined by the 1990 Census. More saturated 
blues indicate higher density. 

VAP90 BlackHisp (15pct 
increments) 

This theme classifies voting age population (18 years 
of age and older) in a 2-dimensional scheme 
according to percentages of Hispanic persons and 
percentages of black (African-American) persons, as 
determined by the 1990 Census. More saturated 
blues indicate higher percentages of Hispanic 
persons. More saturated reds indicate higher 
percentages of black persons. Purples indicate 
concentrations of both Hispanics and blacks in the 
same area. Class breaks occur in increments of 15%, 
beginning at zero. Data are displayed for different 
levels of census geography depending on the scale 
of the map. At local map extents, blocks are shaded. 
At higher levels (county, regional, or statewide), block 
groups are shaded. 

VAP90 BlackHisp (5pct 
increments) 

This theme is like the "VAP90 BlackHisp (15pct 
increments)" theme, except class breaks occur in 
increments of 5%, beginning at zero. 
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2000 Census 

These themes are labels indicating raw count values for total population and 
voting age population based on 2000 Census data. 

For all population label themes, data are displayed for different levels of census 
geography depending on the scale of the map. At the statewide map extent, no 
labels appear. At a regional level, labels for entire counties appear. At a local or 
county level, labels for tracts appear. At a neighborhood level, labels for 
individual blocks appear. Labels are placed at the geometric center of a unit of 
geography, which in some cases is outside its boundaries. 
 

TPop00 Counts This theme puts labels on the map showing counts of total 
population determined by the 2000 Census.  

TVAP00 Counts This theme puts labels on the map showing counts of total 
voting age population (18 years of age and older) determined by 
the 2000 Census. 
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2000 Census--More Count Labels 

These themes are labels indicating counts in the 2000 Census for total 
population and voting age population, broken down by race and ethnicity. 

For all population label themes, data are displayed for different levels of census 
geography depending on the scale of the map. At the statewide map extent, no 
labels appear. At a regional level, labels for entire counties appear. At a local or 
county level, labels for tracts appear. At a neighborhood level, labels for 
individual blocks appear. Labels are placed at the geometric center of a unit of 
geography, which in some cases is outside its boundaries.  
 

A65Up00 Counts This theme labels the map with counts of people age 65 and older, 
as determined by the 2000 Census. 

FemPop00 
Counts 

This theme labels the map with counts of females, as determined 
by the 2000 Census. 

FemVAP00 
Counts 

This theme labels the map with counts of women 18 years of age 
and over, as determined by the 2000 Census. 

HBPop00 Counts This theme puts labels on the map showing counts of Hispanic 
black persons (i.e., persons of Hispanic origin who identified 
themselves as black or African-American, either alone or in 
combination with other racial classifications), as determined by the 
2000 Census.  

HBVAP00 Counts This theme labels the map with counts of Hispanic black voting 
age persons (i.e., persons 18 years of age and over who are of 
Hispanic origin and who identified themselves as black or African-
American, either alone or in combination with other racial 
classifications), as determined by the 2000 Census. 

HxBPop00 
Counts 

This theme labels the map with counts of persons of Hispanic 
origin, excluding Hispanic blacks, as determined by the 2000 
Census. 

HxBVAP00 
Counts 

This theme labels the map with counts of persons of Hispanic 
origin who are 18 years of age and over, excluding Hispanic 
blacks, as determined by the 2000 Census. 

MalePop00 
Counts 

This theme labels the map with counts of males, as determined by 
the 2000 Census. 
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MaleVAP00 
Counts 

This theme labels the map with counts of men 18 years of age and 
over, as determined by the 2000 Census. 

NHBPop00 
Counts 

This theme labels the map with counts of non-Hispanic black 
(African-American) persons, (persons who chose black, either 
alone or in combination with other racial classifications), as 
determined by the 2000 Census. 

NHBVAP00 
Counts 

This theme labels the map with counts of non-Hispanic black 
(African-American) persons 18 years of age and over (persons 
who chose black, either alone or in combination with other racial 
classifications), as determined by the 2000 Census. 

OthPop00 Counts This theme labels the map with counts of non-Hispanic other 
persons (i.e., persons who are not of Hispanic origin and who 
either identified themselves as Asian, Hawaiian, Native American, 
Pacific Islander, or Other alone or who chose more than one racial 
classification but did not choose Black), as determined by the 2000 
Census. 

OthVAP00 
Counts 

This theme labels the map with counts of non-Hispanic other 
voting age persons (i.e., persons 18 years of age and over who 
are not of Hispanic origin and who either identified themselves as 
Asian, Hawaiian, Native American, Pacific Islander, or Other alone 
or who chose more than one racial classification but did not 
choose Black), as determined by the 2000 Census. 

SRWPop00 
Counts 

This theme labels the map with counts of non-Hispanic, single-
race white persons (who chose "white" alone as their racial 
classification), as determined by the 2000 Census. 

SRWVAP00 
Counts 

This theme labels the map with counts of non-Hispanic, single-
race white persons 18 years of age and over (who chose "white" 
alone as their racial classification), as determined by the 2000 
Census. 
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2000 Census--Percentage Labels 

These themes are labels indicating population percentages in the 2000 Census, 
broken down by race and ethnicity.  

For all population label themes, data are displayed for different levels of census 
geography depending on the scale of the map. At the statewide map extent, no 
labels appear. At a regional level, labels for entire counties appear. At a local or 
county level, labels for tracts appear. At a neighborhood level, labels for 
individual blocks appear. Labels are placed at the geometric center of a unit of 
geography, which in some cases is outside its boundaries.  
 

A65Up00 
Percentages 

This theme labels the map with percentages of persons age 65 
and older, relative to the total population, as determined by the 
2000 Census. 

FemPop00 
Percentages 

This theme labels the map with percentages of females, 
relative to the total population, as determined by the 2000 
Census. 

FemVAP00 
Percentages 

This theme labels the map with percentages of women 18 
years of age and over, relative to the total voting age 
population, as determined by the 2000 Census. 

HBPop00 
Percentages 

This theme puts labels on the map showing percentages of 
Hispanic black persons (i.e., persons of Hispanic origin who 
identified themselves as black or African-American, either 
alone or in combination with other racial classifications), 
relative to the total population, as determined by the 2000 
Census.  

HBVAP00 
Percentages 

This theme labels the map with percentages of Hispanic black 
voting age persons (i.e., persons 18 years of age and over who 
are of Hispanic origin and who identified themselves as black 
or African-American, either alone or in combination with other 
racial classifications), relative to the total voting age population, 
as determined by the 2000 Census. 

HxBPop00 
Percentages 

This theme labels the map with percentages of persons of 
Hispanic origin, excluding Hispanic blacks, relative to the total 
population, as determined by the 2000 Census. 
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HxBVAP00 
Percentages 

This theme labels the map with percentages of persons of 
Hispanic origin who are 18 years of age and over, excluding 
Hispanic blacks, relative to the total voting age population, as 
determined by the 2000 Census. 

MalePop00 
Percentages 

This theme labels the map with percentages of males, relative 
to the total population, as determined by the 2000 Census. 

MaleVAP00 
Percentages 

This theme labels the map with percentages of men 18 years 
of age and over, relative to the total voting age population, as 
determined by the 2000 Census. 

NHBPop00 
Percentages 

This theme labels the map with percentages of non-Hispanic 
black (African-American) persons (persons who chose black, 
either alone or in combination with other racial classifications), 
relative to the total population, as determined by the 2000 
Census. 

NHBVAP00 
Percentages 

This theme labels the map with percentages of non-Hispanic 
black (African-American) persons 18 years of age and over 
(persons who chose black, either alone or in combination with 
other racial classifications), relative to the total voting age 
population, as determined by the 2000 Census. 

OthPop00 
Percentages 

This theme labels the map with percentages of non-Hispanic 
other persons (i.e., persons who are not of Hispanic origin and 
who either identified themselves as Asian, Hawaiian, Native 
American, Pacific Islander, or Other alone or who chose more 
than one racial classification but did not choose Black), relative 
to the total population, as determined by the 2000 Census. 

OthVAP00 
Percentages 

This theme labels the map with percentages of non-Hispanic 
other voting age persons (i.e., persons 18 years of age and 
over who are not of Hispanic origin and who either identified 
themselves as Asian, Hawaiian, Native American, Pacific 
Islander, or Other alone or who chose more than one racial 
classification but did not choose Black), relative to the total 
voting age population, as determined by the 2000 Census. 

SRWPop00 
Percentages 

This theme labels the map with percentages of non-Hispanic, 
single-race white persons (who chose "white" alone as their 
racial classification), relative to the total population, as 
determined by the 2000 Census. 
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SRWVAP00 
Percentages 

This theme labels the map with percentages of non-Hispanic, 
single-race white persons 18 years of age and over (who 
chose "white" alone as their racial classification), relative to the 
total voting age population, as determined by the 2000 Census. 
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2000 Census--Shaded Themes 

The first two themes in this set show changes in population that occurred 
between the 1990 Census and the 2000 Census. The third theme depicts 
population density based on the 2000 Census. The last two themes depict 
percentages of black and Hispanic voting age population in the 2000 Census. 
See Legends for visual breakouts. 
 

Age65up00 (BlkGrp) This theme depicts by block group the percentage of 
persons age 65 and older, relative to total population, 
as determined by the 2000 Census. Darker brown 
tones indicate higher percentages while darker green 
tones indicate lower percentages. 

Female Pop00 (BlkGrp) This theme depicts by block group the percentage of 
females, relative to total population, as determined by 
the 2000 Census.  Darker green tones indicate higher 
percentages while darker brown tones indicate lower 
percentages. 

Female VAP00 (BlkGrp) This theme depicts by block group the percentage of 
women 18 years of age and over, relative to total 
voting age population, as determined by the 2000 
Census.  Darker green tones indicate higher 
percentages while darker brown tones indicate lower 
percentages. 

Male Pop00 (BlkGrp) This theme depicts by block group the percentage of 
males, relative to total population, as determined by 
the 2000 Census.  Darker brown tones indicate lower 
percentages while darker green tones indicate higher 
percentages. 

Male VAP00 (BlkGrp) This theme depicts by block group the percentage of 
men 18 years of age and over, relative to total voting 
age population, as determined by the 2000 Census.  
Darker brown tones indicate lower percentages while 
darker green tones indicate higher percentages. 
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TPop Growth Per Sq Mile 
(BlkGrp) 

This theme depicts the difference in density of 
population in block groups between 1990 and 2000, 
measured in persons per square mile. Ascending 
positive numbers, represented by more saturated 
blues, indicate higher growth areas. Descending 
negative numbers, represented by more saturated 
reds, indicate areas that lost population between 1990 
and 2000. 

TPop Growth Percentage 
(BlkGrp) 

This theme depicts the rate of population growth of 
population in block groups between 1990 and 2000 
(difference in total population between 2000 and 1990, 
relative to the population in 1990). More saturated 
blues, indicate areas that grew more rapidly than the 
statewide average of 23.53%. More saturated reds, 
indicate areas that did not keep up with the statewide 
average. Block groups that had no population in 1990 
are attributed with "0" if the block group still had no 
population in 2000 and with an extreme positive value 
otherwise. 

TPop00 Per Sq Mile (BlkGrp) This theme depicts the density of population in block 
groups, measured in persons per square mile, as 
determined by the 2000 Census. More saturated blues 
indicate higher density. 

VAP00 BlackHisp (15pct 
increments) 

This theme classifies voting age population (18 years 
of age and older) in a 2-dimensional scheme 
according to percentages of Hispanic persons and 
percentages of black (African-American) persons, as 
determined by the 2000 Census. More saturated blues 
indicate higher percentages of Hispanic persons. More 
saturated reds indicate higher percentages of black 
persons. Purples indicate concentrations of both 
Hispanics and blacks in the same area. Class breaks 
occur in increments of 15%, beginning at zero. Data 
are displayed for different levels of census geography 
depending on the scale of the map. At local map 
extents, blocks are shaded. At higher levels (county, 
regional, or statewide), block groups are shaded. 

VAP00 BlackHisp (5pct 
increments) 

This theme is like the "VAP00 BlackHisp (15pct 
increments)" theme, except class breaks occur in 
increments of 5%, beginning at zero. 
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 SocioEconomic Factors (1990 Census) 
All Persons Economics 

These themes use shading to depict select employment and income data from 
the 1990 Census (Summary Tape File 3). They are displayed using 1990 block 
group geography. The United States Census Bureau plans to publish detailed 
socioeconomic data from the 2000 Census (Summary File 3) near the end of 
2002.  
 

Average Family Income Areas with the lowest levels of family income are 
depicted in more saturated tans. Areas with the 
highest levels are depicted in more saturated 
greens. Areas with levels near the state average 
($41,860) are depicted in white.  

Average Household Income Areas with the lowest average family incomes are 
depicted in more saturated tans. Areas with the 
highest levels are depicted in more saturated 
greens. Areas with levels near the state average 
($36,517) are depicted in white. 

Below Poverty Level (Families) Areas with the largest percentages of families 
having incomes below poverty level are depicted 
in more saturated tans. Areas with the smallest 
percentages are depicted in more saturated 
greens. Areas with percentages near the state 
average (9%) are depicted in white.  

Employed 40 Weeks or More 
(Year) 

Areas with the smallest percentages of workers 
employed 40 weeks or more per year are depicted 
in more saturated tans. Areas with the largest 
percentages are depicted in more saturated 
greens. Areas with percentages near the state 
average (42.9%) are depicted in white. 

Managerial and Professional 
Occupations 

Areas with the smallest percentages of workers 
employed in managerial and professional 
occupations are depicted in more saturated tans. 
Areas with the largest percentages are depicted in 
more saturated greens. Areas with percentages 
near the state average (25.2%) are depicted in 
white. 
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Median Family Income Areas with the lowest median family incomes are 
depicted in more saturated tans. Areas with the 
highest levels are depicted in more saturated 
greens. Areas with levels near the state average 
($32,212) are depicted in white. 

Per Capita Income Areas with the lowest per capita incomes are 
depicted in more saturated tans. Areas with the 
highest levels are depicted in more saturated 
greens. Areas with levels near the state average 
($14,698) are depicted in white. 

Unemployed Areas with the largest percentages of unemployed 
workers are depicted in more saturated tans. 
Areas with the smallest percentages are depicted 
in more saturated greens. Areas with percentages 
near the state average (3.4%) are depicted in 
white. 
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All Persons Education 

These themes use shading to depict select education data from the 1990 Census 
(Summary Tape File 3). They are displayed using 1990 block group geography. 
The United States Census Bureau plans to publish detailed socioeconomic data 
from the 2000 Census (Summary File 3) near the end of 2002.  
 

Children in Private Schools 
(K-12) 

Areas with the smallest percentages of school age 
children attending private schools (K-12) are depicted in 
more saturated tans. Areas with the largest percentages 
are depicted in more saturated greens. Areas with 
percentages near the state average (10.2%) are depicted 
in white.  

Children in Public Schools 
(K-12) 

Areas with the largest percentages of school age children 
attending public schools (K-12) are depicted in more 
saturated tans. Areas with the smallest percentages 
(89.8%) are depicted in more saturated greens. Areas 
with percentages near the state average are depicted in 
white. 

College Graduates Areas with the smallest percentages of adults 25 years of 
age and older who graduated from college are depicted in 
more saturated tans. Areas with the largest percentages 
are depicted in more saturated greens. Areas with 
percentages near the state average (18.3%) are depicted 
in white. 

High School Graduates Areas with the smallest percentages of adults 25 years of 
age and older who graduated from high school are 
depicted in more saturated tans. Areas with the largest 
percentages are depicted in more saturated greens. 
Areas with percentages near the state average (74.4%) 
are depicted in white. 
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All Persons Housing 

These themes use shading to depict select housing data from the 1990 Census 
(Summary Tape File 3). They are displayed using 1990 block group geography. 
The United States Census Bureau plans to publish detailed socioeconomic data 
from the 2000 Census (Summary File 3) near the end of 2002.  
 

Average House Value Areas with the lowest average house values are depicted 
in more saturated tans. Areas with the highest values are 
depicted in more saturated greens. Areas with values 
near the state average ($98,476) are depicted in white.  

Dwellings with No 
Telephone 

Areas with the largest percentages of households that do 
not have telephone service installed are depicted in more 
saturated tans. Areas with the smallest percentages are 
depicted in more saturated greens. Areas with 
percentages near the state average (5.3%) are depicted 
in white. 

Houses Valued $50,000 or 
More 

Areas with the smallest percentages of housing units 
valued $50,000 or more are depicted in more saturated 
tans. Areas with the largest percentages are depicted in 
more saturated greens. Areas with percentages near the 
state average (81.3%) are depicted in white. 

Median House Value Areas with the lowest median house values are depicted 
in more saturated tans. Areas with the highest values are 
depicted in more saturated greens. Areas with values 
near the state average ($76,500) are depicted in white. 

Mortgage $700 Per Month 
or More 

Areas with the smallest percentages of housing units with 
mortgage payments of $700 or more per month are 
depicted in more saturated tans. Areas with the largest 
percentages are depicted in more saturated greens. 
Areas with percentages near the state average (52.1%) 
are depicted in white. 

Owner-occupied Dwellings Areas with the smallest percentages of housing units 
occupied by owners are depicted in more saturated tans. 
Areas with the largest percentages are depicted in more 
saturated greens. Areas with percentages near the state 
average (67.2%) are depicted in white. 
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Persons per Dwelling Unit Areas with the largest numbers of persons per dwelling 
unit are depicted in more saturated tans. Areas with the 
smallest numbers are depicted in more saturated greens. 
Areas with numbers near the state average (2.5%) are 
depicted in white. 

Rent $500 per Month or 
More 

Areas with the smallest percentages of rental housing 
units with rent payments of $500 or more per month are 
depicted in more saturated tans. Areas with the largest 
percentages are depicted in more saturated greens. 
Areas with percentages near the state average (43.7%) 
are depicted in white. 

Vacant Housing Units Areas with the largest percentages of vacant housing 
units are depicted in more saturated tans. Areas with the 
smallest percentages are depicted in more saturated 
greens. Areas with percentages near the state average 
(15.8%) are depicted in white. 
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All Persons Other 

These themes use shading to depict select socioeconomic data from the 1990 
Census (Summary Tape File 3). They are displayed using 1990 block group 
geography. The United States Census Bureau plans to publish detailed 
socioeconomic data from the 2000 Census (Summary File 3) near the end of 
2002.  
 

Age 65 and Older Areas with the smallest percentages of persons 65 
years or age and older are depicted in more 
saturated tans. Areas with the largest percentages 
are depicted in more saturated greens. Areas with 
percentages near the state average (18.3%) are 
depicted in white.  

Average Age Areas with the lowest average ages are depicted in 
more saturated tans. Areas with the highest 
averages are depicted in more saturated greens. 
Areas with averages near the state average (39) are 
depicted in white. 

Born in Florida Areas with the largest percentages of persons who 
were born in Florida are depicted in more saturated 
tans. Areas with the smallest percentages are 
depicted in more saturated greens. Areas with 
percentages near the state average (30.5%) are 
depicted in white. 

Changed Residence Within Last 
5 Years 

Areas with the smallest percentages of households 
that have changed residences within the past 5 
years are depicted in more saturated tans. Areas 
with the largest percentages are depicted in more 
saturated greens. Areas with percentages near the 
state average (55.1%) are depicted in white. 

Households With No Vehicle Areas with the largest percentages of households 
who do not own a motor vehicle are depicted in 
more saturated tans. Areas with the smallest 
percentages are depicted in more saturated greens. 
Areas with percentages near the state average 
(9.2%) are depicted in white. 
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Inside and Urban Area Areas with the largest percentages of households 
residing inside urban areas are depicted in more 
saturated tans. Areas with the smallest percentages 
are depicted in more saturated greens. Areas with 
percentages near the state average (78.7%) are 
depicted in white. 

Married Couple Households Areas with the smallest percentages of married 
couple households are depicted in more saturated 
tans. Areas with the largest percentages are 
depicted in more saturated greens. Areas with 
percentages near the state average (55.4%) are 
depicted in white. 

Non-family Households Areas with the largest percentages of non-family 
households are depicted in more saturated tans. 
Areas with the smallest percentages are depicted in 
more saturated greens. Areas with percentages 
near the state average (31.1%) are depicted in 
white. 

 



 

 

122 

Socioeconomic Factors Broken Down by Race 

In addition to the socioeconomic factors tabulated for the entire population, 
several are broken down by race and Hispanic origin. For each of the factors 
listed below, separate themes are available for Blacks, Hispanics, Non-Blacks, 
and Non-Hispanics. When these themes are added to the map, the name in the 
Theme Manager is prefixed with [B], [H], [NB], or [NH] indicating that the theme 
applies to a particular subset of the population. These socioeconomic themes 
use data from the 1990 Census and are displayed using 1990 block group 
geography. The United States Census Bureau plans to publish detailed 
socioeconomic data from the 2000 Census (Summary File 3) near the end of 
2002. 
 

Age 65 and Older Areas with the largest percentages of persons 65 years 
of age and older are depicted in more saturated tans. 
Areas with the smallest percentages are depicted in 
more saturated greens. Areas with percentages near the 
state average are depicted in white. 

Average Age Areas with the lowest average age are depicted in more 
saturated tans. Areas with the highest averages are 
depicted in more saturated greens. Areas with averages 
near the state average are depicted in white. 

Average Household Income Areas with the lowest average household incomes are 
depicted in more saturated tans. Areas with the highest 
levels are depicted in more saturated greens. Areas with 
levels near the state average are depicted in white. 

Below Poverty Level 
(Families) 

Areas with the largest percentages of families having 
incomes below poverty level are depicted in more 
saturated tans. Areas with the smallest percentages are 
depicted in more saturated greens. Areas with 
percentages near the state average are depicted in 
white. 

College Graduates Areas with the smallest percentages of adults 25 years 
of age and older who graduated from college are 
depicted in more saturated tans. Areas with the largest 
percentages are depicted in more saturated greens. 
Areas with percentages near the state average are 
depicted in white. 
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High School Graduates Areas with the smallest percentages of adults 25 years 
of age and older who graduated from high school are 
depicted in more saturated tans. Areas with the largest 
percentages are depicted in more saturated greens. 
Areas with percentages near the state average are 
depicted in white. 

Households with No Vehicle Areas with the largest percentages of households that do 
not own a motor vehicle are depicted in more saturated 
tans. Areas with the smallest percentages are depicted 
in more saturated greens. Areas with percentages near 
the state average are depicted in white. 

Married Couple Households Areas with the smallest percentages of married couple 
households are depicted in more saturated tans. Areas 
with the largest percentages are depicted in more 
saturated greens. Areas with percentages near the state 
average are depicted in white. 

Mortgage $700 per Month 
or More 

Areas with the smallest percentages of housing units 
with mortgage payments of $700 or more per month are 
depicted in more saturated tans. Areas with the largest 
percentages are depicted in more saturated greens. 
Areas with percentages near the state average are 
depicted in white. 

Non-family Households Areas with the largest percentages of non-family 
households are depicted in more saturated tans. Areas 
with the smallest percentages are depicted in more 
saturated greens. Areas with percentages near the state 
average are depicted in white. 

Owner-occupied Dwellings Areas with the smallest percentages of housing units 
occupied by owners are depicted in more saturated tans. 
Areas with the largest percentages are depicted in more 
saturated greens. Areas with percentages near the state 
average are depicted in white. 

Per Capita Income Areas with the lowest per capita incomes are depicted in 
more saturated tans. Areas with the highest levels are 
depicted in more saturated greens. Areas with levels 
near the state average are depicted in white. 
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Persons per Dwelling Unit Areas with the largest numbers of persons per dwelling 
unit are depicted in more saturated tans. Areas with the 
smallest numbers are depicted in more saturated greens. 
Areas with numbers near the state average are depicted 
in white. 

Rent $500 per Month or 
More 

Areas with the smallest percentages of rental housing 
units with rent payments of $500 or more per month are 
depicted in more saturated tans. Areas with the largest 
percentages are depicted in more saturated greens. 
Areas with percentages near the state average are 
depicted in white. 

Unemployed Areas with the largest percentages of unemployed 
workers are depicted in more saturated tans. Areas with 
the smallest percentages are depicted in more saturated 
greens. Areas with percentages near the state average 
are depicted in white. 
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Statistics 

What Statistics are Available 

Statistics are available in FREDS 2000 from the layers in the map, from the data 
in the statistics grid, and from support databases outside the FREDS 2000 
environment. These data can be exported to Microsoft Access or Microsoft Excel 
or other programs to manipulate them and create reports. Two standard reports 
come with FREDS 2000 to allow you to quickly generate basic statistics. 

The available statistics are presented in a grid beneath the map in the FREDS 
2000 interface. Radio buttons to the left of the map determine whether the grid 
shows District statistics or District by County Statistics and whether it shows all 
districts, only the districts affected by the most recent selection, all counties, or 
only the counties affected by the most recent selection. 

You can choose which districts show in the statistics grid by selecting Districts of 
Interest from the Settings menu. In addition, you can choose which statistics are 
visible by selecting Statistics of Interest from the Settings menu. 

You can change the height of the statistics grid to show more or fewer statistics 
by placing your cursor over the thin gray bar between the grid and the map. Click 
and drag the gray bar up or down to change the height. Your cursor should 
change to an up and down arrow icon when you click. 
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List of Statistics Included 
 

Population 

TPop00 Total Population (2000 Census) 

SRWPop00 Single-Race Non-Hispanic White 
Population (2000 Census) 

%SRWPop00 Single-Race Non-Hispanic White 
Population (2000 Census) 

NHBPop00 Non-Hispanic Black Population 
including multirace (2000 Census) 

%NHBPop00 Non-Hispanic Black Population 
including multirace (2000 Census) 

HBPop00 Hispanic Black Population including 
multirace (2000 Census) 

%HBPop00 Hispanic Black Population including 
multirace (2000 Census) 

HxBPop00 Hispanic Population excluding Hispanic 
Black (2000 Census) 

%HxBPop00 Hispanic Population excluding Hispanic 
Black (2000 Census) 

OthPop00 Other (none of the above) Population 
(2000 Census) 

%OthPop00 Other (none of the above) Population 
(2000 Census) 

TVAP00 Total Voting Age Population (2000 
Census) 

SRWVAP00 Single-Race Non-Hispanic White Voting 
Age Population (2000 Census) 
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%SRWVAP00 Single-Race Non-Hispanic White Voting 
Age Population (2000 Census) 

NHBVAP00 Non-Hispanic Black Voting Age 
Population including multirace (2000 
Census) 

%NHBVAP00 Non-Hispanic Black Voting Age 
Population including multirace (2000 
Census) 

HBVAP00 Hispanic Black Voting Age Population 
including multirace (2000 Census) 

%HBVAP00 Hispanic Black Voting Age Population 
including multirace (2000 Census) 

HxBVAP00 Hispanic Voting Age Population 
excluding Hispanic Black (2000 
Census) 

%HxBVAP00 Hispanic Voting Age Population 
excluding Hispanic Black (2000 
Census) 

OthVAP00 Other (none of the above) Voting Age 
Population (2000 Census) 

%OthVAP00 Other (none of the above) Voting Age 
Population (2000 Census) 

TPop90 Total Population (1990 Census) 

MalePop00 Male Population (2000 Census) 

%MalePop00 Male Population (2000 Census) 

FemPop00 Female Population (2000 Census) 

%FemPop00 Female Population (2000 Census) 

Age65UpPop00 Age 65 and Older Population (2000 
Census) 

%Age65UpPop00 Age 65 and Older Population (2000 
Census) 
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NHWPop90 Non-Hispanic White Population (1990 
Census) 

%NHWPop90 Non-Hispanic White Population (1990 
Census) 

NHBPop90 Non-Hispanic Black Population (1990 
Census) 

%NHBPop90 Non-Hispanic Black Population (1990 
Census) 

HBPop90 Hispanic Black Population (1990 
Census) 

%HBPop90 Hispanic Black Population (1990 
Census) 

HxBPop90 Hispanic Population excluding Hispanic 
Black (1990 Census) 

%HxBPop90 Hispanic Population excluding Hispanic 
Black (1990 Census) 

NHOPop90 Non-Hispanic Asian Native American or 
Other Population (1990 Census) 

%NHOPop90 Non-Hispanic Asian Native American or 
Other Population (1990 Census) 

TVAP90 Total Voting Age Population (1990 
Census) 

NHWVAP90 Non-Hispanic White Voting Age 
Population (1990 Census) 

%NHWVAP90 Non-Hispanic White Voting Age 
Population (1990 Census) 

NHBVAP90 Non-Hispanic Black Voting Age 
Population (1990 Census) 

%NHBVAP90 Non-Hispanic Black Voting Age 
Population (1990 Census) 
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HBVAP90 Hispanic Black Voting Age Population 
(1990 Census) 

%HBVAP90 Hispanic Black Voting Age Population 
(1990 Census) 

HxBVAP90 Hispanic Voting Age Population 
excluding Hispanic Black (1990 
Census) 

%HxBVAP90 Hispanic Voting Age Population 
excluding Hispanic Black (1990 
Census) 

NHOVAP90 Non-Hispanic Asian Native American or 
Other Voting Age Population (1990 
Census) 

%NHOVAP90 Non-Hispanic Asian Native American or 
Other Voting Age Population (1990 
Census) 
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Voter Registration 

TotalRV00 Total Registered Voters (2000) 

RepRV00 Republican Registered Voters (2000) 

%RepRV00 Republican Registered Voters (2000) 

DemRV00 Democratic Registered Voters (2000) 

%DemRV00 Democratic Registered Voters (2000) 

IndRV00 No Party Affiliation or Minor Party 
Registered Voters (2000) 

%IndRV00 No Party Affiliation or Minor Party 
Registered Voters (2000) 

TotalRV98 Total Registered Voters (1998) 

RepRV98 Republican Registered Voters (1998) 

%RepRV98 Republican Registered Voters (1998) 

DemRV98 Democratic Registered Voters (1998) 

%DemRV98 Democratic Registered Voters (1998) 

IndRV98 No Party Affiliation or Minor Party 
Registered Voters (1998) 

%IndRV98 No Party Affiliation or Minor Party 
Registered Voters (1998) 

TotalRV96 Total Registered Voters (1996) 

RepRV96 Republican Registered Voters (1996) 

%RepRV96 Republican Registered Voters (1996) 

DemRV96 Democratic Registered Voters (1996) 

%DemRV96 Democratic Registered Voters (1996) 
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IndRV96 No Party Affiliation or Minor Party 
Registered Voters (1996) 

%IndRV96 No Party Affiliation or Minor Party 
Registered Voters (1996) 

WhiteRV00 White Registered Voters (2000) 

%WhiteRV00 White Registered Voters (2000) 

BlackRV00 Black Registered Voters (2000) 

%BlackRV00 Black Registered Voters (2000) 

HispRV00 Hispanic Registered Voters (2000) 

%HispRV00 Hispanic Registered Voters (2000) 

OtherRV00 Other Race Registered Voters (2000) 

%OtherRV00 Other Race Registered Voters (2000) 

WRepRV00 White Republican Registered Voters 
(2000) 

%WRepRV00 White Republican Registered Voters 
(2000) 

BRepRV00 Black Republican Registered Voters 
(2000) 

%BRepRV00 Black Republican Registered Voters 
(2000) 

HRepRV00 Hispanic Republican Registered Voters 
(2000) 

%HRepRV00 Hispanic Republican Registered Voters 
(2000) 

ORepRV00 Other Race Republican Registered 
Voters (2000) 

%ORepRV00 Other Race Republican Registered 
Voters (2000) 
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WDemRV00 White Democratic Registered Voters 
(2000) 

%WDemRV00 White Democratic Registered Voters 
(2000) 

BDemRV00 Black Democratic Registered Voters 
(2000) 

%BDemRV00 Black Democratic Registered Voters 
(2000) 

HDemRV00 Hispanic Democratic Registered Voters 
(2000) 

%HDemRV00 Hispanic Democratic Registered Voters 
(2000) 

ODemRV00 Other Race Democratic Registered 
Voters (2000) 

%ODemRV00 Other Race Democratic Registered 
Voters (2000) 

WIndRV00 White No Party Affiliation or Minor Party 
Registered Voters (2000) 

%WIndRV00 White No Party Affiliation or Minor Party 
Registered Voters (2000) 

BIndRV00 Black No Party Affiliation or Minor Party 
Registered Voters (2000) 

%BIndRV00 Black No Party Affiliation or Minor Party 
Registered Voters (2000) 

HIndRV00 Hispanic No Party Affiliation or Minor 
Party Registered Voters (2000) 

%HIndRV00 Hispanic No Party Affiliation or Minor 
Party Registered Voters (2000) 

OIndRV00 Other Race No Party Affiliation or Minor 
Party Registered Voters (2000) 
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%OIndRV00 Other Race No Party Affiliation or Minor 
Party Registered Voters (2000) 

Age18to29RV00 Age 18 to 29 Registered Voters (2000) 

%Age18to29RV00 Age 18 to 29 Registered Voters (2000) 

Age30to44RV00 Age 30 to 44 Registered Voters (2000) 

%Age30to44RV00 Age 30 to 44 Registered Voters (2000) 

Age45to54RV00 Age 45 to 54 Registered Voters (2000) 

%Age45to54RV00 Age 45 to 54 Registered Voters (2000) 

Age55to64RV00 Age 55 to 64 Registered Voters (2000) 

%Age55to64RV00 Age 55 to 64 Registered Voters (2000) 

Age65UpRV00 Age 65 and Older Registered Voters 
(2000) 

%Age65UpRV00 Age 65 and Older Registered Voters 
(2000) 

MaleRV00 Male Registered Voters (2000) 

%MaleRV00 Male Registered Voters (2000) 

FemaleRV00 Female Registered Voters (2000) 

%FemaleRV00 Female Registered Voters (2000) 
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Elections 

G00PRE_VotesCast Major Party Candidates President of the 
U.S. (2000) 

G00PRE_R_Bush President of the U.S. (2000) 

%G00PRE_R_Bush President of the U.S. (2000) 

G00PRE_D_Gore President of the U.S. (2000) 

%G00PRE_D_Gore President of the U.S. (2000) 

G00PRE_G_Nader President of the U.S. (2000) 

%G00PRE_G_Nader President of the U.S. (2000) 

G00PRE_Others President of the U.S. (2000). Votes for 
Harry Browne (LIB), James Harris (SWP), 
John Hagelin (LAW), Pat Buchanan (REF), 
David McReynolds (SPF), Howard Phillips 
(CPF), Monica Moorehead (WWF), and all 
write-in candidates (WRI) are aggregated 
together.  

%G00PRE_Others President of the U.S. (2000). Votes for 
Harry Browne (LIB), James Harris (SWP), 
John Hagelin (LAW), Pat Buchanan (REF), 
David McReynolds (SPF), Howard Phillips 
(CPF), Monica Moorehead (WWF), and all 
write-in candidates (WRI) are aggregated 
together.  

G00USS_VotesCast Major Party Candidates U.S. Senate (2000) 

G00USS_R_McCollum U.S. Senate (2000) 

%G00USS_R_McCollum U.S. Senate (2000) 

G00USS_D_Nelson U.S. Senate (2000) 

%G00USS_D_Nelson U.S. Senate (2000) 
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G00TRE_VotesCast Major Party Candidates Treasurer and Ins. 
Comm. (2000) 

G00TRE_R_Gallagher Treasurer and Ins. Comm. (2000) 

%G00TRE_R_Gallagher Treasurer and Ins. Comm. (2000) 

G00TRE_D_Cosgrove Treasurer and Ins. Comm. (2000) 

%G00TRE_D_Cosgrove Treasurer and Ins. Comm. (2000) 

G00EDU_VotesCast Major Party Candidates Comm. of 
Education (2000) 

G00EDU_R_Crist Comm. of Education (2000) 

%G00EDU_R_Crist Comm. of Education (2000) 

G00EDU_D_Sheldon Comm. of Education (2000) 

%G00EDU_D_Sheldon Comm. of Education (2000) 

P00EDU_VotesCast Major Party Candidates Democratic Primary 
Comm. of Education (2000) 

P00EDU_Bush Democratic Primary Comm. of Education 
(2000) 

%P00EDU_Bush Democratic Primary Comm. of Education 
(2000) 

P00EDU_Sheldon Democratic Primary Comm. of Education 
(2000) 

%P00EDU_Sheldon Democratic Primary Comm. of Education 
(2000) 

G98USS_VotesCast Major Party Candidates U.S. Senate (1998) 

G98USS_R_Crist U.S. Senate (1998) 

%G98USS_R_Crist U.S. Senate (1998) 

G98USS_D_Graham U.S. Senate (1998) 
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%G98USS_D_Graham U.S. Senate (1998) 

G98GOV_VotesCast Major Party Candidates Governor (1998) 

G98GOV_R_Bush Governor (1998) 

%G98GOV_R_Bush Governor (1998) 

G98GOV_D_MacKay Governor (1998) 

%G98GOV_D_MacKay Governor (1998) 

G98SEC_VotesCast Major Party Candidates Secretary of State 
(1998) 

G98SEC_R_Harris Secretary of State (1998) 

%G98SEC_R_Harris Secretary of State (1998) 

G98SEC_D_Gievers Secretary of State (1998) 

%G98SEC_D_Gievers Secretary of State (1998) 

G98ATG_VotesCast Major Party Candidates Attorney General 
(1998) 

G98ATG_R_Bludworth Attorney General (1998) 

%G98ATG_R_Bludworth Attorney General (1998) 

G98ATG_D_Butterworth Attorney General (1998) 

%G98ATG_D_Butterworth Attorney General (1998) 

G98CMP_VotesCast Major Party Candidates Comptroller (1998) 

G98CMP_R_Milligan Comptroller (1998) 

%G98CMP_R_Milligan Comptroller (1998) 

G98CMP_D_Daughtrey Comptroller (1998) 

%G98CMP_D_Daughtrey Comptroller (1998) 

G98TRE_VotesCast Major Party Candidates Treasurer and Ins. 
Comm. (1998) 
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G98TRE_R_Ireland Treasurer and Ins. Comm. (1998) 

%G98TRE_R_Ireland Treasurer and Ins. Comm. (1998) 

G98TRE_D_Nelson Treasurer and Ins. Comm. (1998) 

%G98TRE_D_Nelson Treasurer and Ins. Comm. (1998) 

G98EDU_VotesCast Major Party Candidates Comm. of 
Education (1998) 

G98EDU_R_Gallagher Comm. of Education (1998) 

%G98EDU_R_Gallagher Comm. of Education (1998) 

G98EDU_D_Wallace Comm. of Education (1998) 

%G98EDU_D_Wallace Comm. of Education (1998) 

G98AGR_VotesCast Major Party Candidates Comm. of 
Agriculture (1998) 

G98AGR_R_Faircloth Comm. of Agriculture (1998) 

%G98AGR_R_Faircloth Comm. of Agriculture (1998) 

G98AGR_D_Crawford Comm. of Agriculture (1998) 

%G98AGR_D_Crawford Comm. of Agriculture (1998) 

G96PRE_VotesCast 3 Leading Candidates President of the U.S. 
(1996) 

G96PRE_R_Dole President of the U.S. (1996) 

%G96PRE_R_Dole President of the U.S. (1996) 

G96PRE_D_Clinton President of the U.S. (1996) 

%G96PRE_D_Clinton President of the U.S. (1996) 

G96PRE_I_Perot President of the U.S. (1996) 

%G96PRE_I_Perot President of the U.S. (1996) 

G94USS_VotesCast Major Party Candidates U.S. Senate (1994) 
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G94USS_R_Mack U.S. Senate (1994) 

%G94USS_R_Mack U.S. Senate (1994) 

G94USS_D_Rodham U.S. Senate (1994) 

%G94USS_D_Rodham U.S. Senate (1994) 

G94GOV_VotesCast Major Party Candidates Governor (1994) 

G94GOV_R_Bush Governor (1994) 

%G94GOV_R_Bush Governor (1994) 

G94GOV_D_Chiles Governor (1994) 

%G94GOV_D_Chiles Governor (1994) 

G94SEC_VotesCast Major Party Candidates Secretary of State 
(1994) 

G94SEC_R_Mortham Secretary of State (1994) 

%G94SEC_R_Mortham Secretary of State (1994) 

G94SEC_D_Saunders Secretary of State (1994) 

%G94SEC_D_Saunders Secretary of State (1994) 

G94ATG_VotesCast Major Party Candidates Attorney General 
(1994) 

G94ATG_R_Ferro Attorney General (1994) 

%G94ATG_R_Ferro Attorney General (1994) 

G94ATG_D_Butterworth Attorney General (1994) 

%G94ATG_D_Butterworth Attorney General (1994) 

G94CMP_VotesCast Major Party Candidates Comptroller (1994) 

G94CMP_R_Milligan Comptroller (1994) 

%G94CMP_R_Milligan Comptroller (1994) 

G94CMP_D_Lewis Comptroller (1994) 
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%G94CMP_D_Lewis Comptroller (1994) 

G94TRE_VotesCast Major Party Candidates Treasurer and Ins. 
Comm. (1994) 

G94TRE_R_Ireland Treasurer and Ins. Comm. (1994) 

%G94TRE_R_Ireland Treasurer and Ins. Comm. (1994) 

G94TRE_D_Nelson Treasurer and Ins. Comm. (1994) 

%G94TRE_D_Nelson Treasurer and Ins. Comm. (1994) 

G94EDU_VotesCast Major Party Candidates Comm. of 
Education (1994) 

G94EDU_R_Brogan Comm. of Education (1994) 

%G94EDU_R_Brogan Comm. of Education (1994) 

G94EDU_D_Jamerson Comm. of Education (1994) 

%G94EDU_D_Jamerson Comm. of Education (1994) 

G94AGR_VotesCast Major Party Candidates Comm. of 
Agriculture (1994) 

G94AGR_R_Smith Comm. of Agriculture (1994) 

%G94AGR_R_Smith Comm. of Agriculture (1994) 

G94AGR_D_Crawford Comm. of Agriculture (1994) 

%G94AGR_D_Crawford Comm. of Agriculture (1994) 

P94EDU_VotesCast Major Party Candidates Democratic Primary 
Comm. of Education (1994) 

P94EDU_Griffin Democratic Primary Comm. of Education 
(1994) 

%P94EDU_Griffin Democratic Primary Comm. of Education 
(1994) 

P94EDU_Jamerson Democratic Primary Comm. of Education 
(1994) 
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%P94EDU_Jamerson Democratic Primary Comm. of Education 
(1994) 

G92PRE_VotesCast 3 Leading Candidates President of the U.S. 
(1992) 

G92PRE_R_Bush President of the U.S. (1992) 

%G92PRE_R_Bush President of the U.S. (1992) 

G92PRE_D_Clinton President of the U.S. (1992) 

%G92PRE_D_Clinton President of the U.S. (1992) 

G92PRE_I_Perot President of the U.S. (1992) 

%G92PRE_I_Perot President of the U.S. (1992) 

G92USS_VotesCast Major Party Candidates U.S. Senate (1992) 

G92USS_R_Grant U.S. Senate (1992) 

%G92USS_R_Grant U.S. Senate (1992) 

G92USS_D_Graham U.S. Senate (1992) 

%G92USS_D_Graham U.S. Senate (1992) 

    

 

Statistical reports 

See Printing Reports. 



 

 

141 

Online Resources 

FREDS 2000 Online Help 

For further information check the FREDS 2000 Help Page at 
http://www.state.fl.us/edr/Redistricting/freds/freds.htm. This site will contain the 
latest news concerning the FREDS 2000 application, including any software 
updates. 
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Glossary 
Block 

An area bounded on all sides by visible and/or invisible features shown on a map 
prepared by the U.S. Census Bureau. A block is the smallest geographic entity 
for which the Census Bureau tabulates decennial census data Florida has 
362,499 blocks. 

Block Group 

A statistical subdivision of a census tract consisting of a cluster of 1 to 999 
census blocks. Block groups generally contain between 300 and 3,000 people, 
with an optimum size of 1,500 people. The block group is the lowest-level 
geographic entity for which the U.S. Census Bureau tabulates sample data from 
a decennial census. Florida has 9,112 block groups. 

Census Geography 

A collective term referring to the geographic entities used by the U.S. Census 
Bureau in its data collection and tabulation operations, including their 
relationships to one another. 

Completeness 

In FREDS 2000, a plan that has all Census geography assigned to districts is 
complete. 

Contiguity 

In FREDS 2000, a district is contiguous if it is defined by a single shape. 

County 

The primary legal division of the state recognized by the U.S. Census Bureau. 
Florida has 67 counties. 

Deviation 

Deviation is the percentage difference between the population of a district and 
the target pouplation. Total deviation for a plan is the difference between the 
population of the district with the most population and the population of the 
district with the least population, divided by the target population. 
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District 

A district is a contiguous geographic area composed of Census geography that is 
designated as a voting area for either Florida House, Florida Senate or 
Congressional seats. 

Extent 

An extent is the portion of the map that is visible in the map display. Panning 
changes the location, but not the size of the extent, while zooming changes both 
the size and location of the extent. 

Geographic Hierarchy 

A geographic presentation that shows the geographic entities in a 
superior/subordinate structure. In this system of relationships among geographic 
entities, each geographic entity (except the smallest one) is subdivided into 
lower-order units that in turn may be subdivided further. For example, states are 
subdivided into counties, which are subdivided into census tracts, which are 
subdivided into census block groups, which in turn are subdivided into census 
blocks. 

Ideal Population 

The "Ideal Population" is the target population for each district in a plan. It is 
calculated by dividing total state population (15,982,378) by the number of 
districts in a plan. 

Incorporated Place 

A type of governmental unit, incorporated under state law as a city, town, 
borough, or village, generally to provide a wide array of specific governmental 
services for a concentration of people within legally prescribed boundaries. 

Municipality 

See Incorporated Place 

Orphan 

In FREDS 2000, an orphan is an unassigned piece of geography. 

Place 

A concentration of population either legally bounded as an incorporated place, or 
delineated for statistical purposes as a census designated place. 
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Plan 

A plan is a group of districts that contains all Census geography for the state of 
Florida and meets the requirements set forth in the Florida Constitution for a 
state House or state Senate plan or meets federal requirements for a 
Congressional plan. The Florida Constitution provides the division of the state 
into not less than 30 nor more than 40 consecutively numbered senatorial 
districts and not less than 80 nor more than 120 consecutively numbered 
representative districts of either contiguous, overlapping or identical territory. The 
current number of Senate seats is 40. The current number of House seats is 120. 
The 2000 Census entitled the State of Florida to 25 representatives in the United 
States House of Representatives. 

Precinct 

A geographic entity established by local government for the purpose of assigning 
voters to polling places and conducting elections. 

Precinct Proxy 

Precinct proxies are pproximations of precinct boundaries for the 2000 elections 
constructed entirely of whole census blocks. Where precinct boundaries match 
census block boundaries, the approximation is exact. Many precinct boundaries 
in Florida do not line up exactly with census block boundaries. In those cases, 
the precinct proxy will not match the official precinct boundaries set by the 
county. Using precinct proxies for building districts may reduce the impact of new 
districts on precincts. 

Reapportionment 

Reapportionment, which occurs at the federal level, is the process of allocating 
the 435 seats in the U.S. House of Representatives among the 50 states based 
on the population of each state. At the conclusion of each census, the Census 
Bureau uses the new population results to calculate the number of congressional 
seats each state is entitled to have. The Census Bureau reports that 
determination to the President by December 31. The President then reports to 
Congress the census counts of each state and the number of Representatives to 
which each state is entitled. Based on official apportionment data submitted to 
the President by the Census Bureau on December 28, 2000, Florida is entitled to 
25 Congressional Districts (an increase of 2 from the 1990 apportionment). 

Redistricting 

Redistricting refers to the process of changing legislative and congressional 
district boundaries. Florida's Congressional districts, Senate districts, and House 
of Representatives districts will be changed in 2002 based on the 2000 Census 
and applicable state and federal law. 
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Straggler 

In FREDS 2000, a straggler is part of a district that is completely surrounded by 
another district. 

Theme 

In FREDS 2000, a theme refers to a layer or set of layers added to the map to 
visually depict data, as filled shapes, labels, lines, points, or a combination. 

Tract 

A small, relatively permanent statistical subdivision of a county, delineated for 
data presentation purposes by a local group of census data users or the 
geographic staff of a regional census center in accordance with U.S. Census 
Bureau guidelines. Originally designed to be relatively homogeneous units with 
respect to population characteristics, economic status, and living conditions at 
the time they are established, census tracts generally contain between 1,000 and 
8,000 people, with an optimum size of 4,000 people. Census tract boundaries are 
delineated with the intention of being stable over many decades, so they 
generally follow relatively permanent visible features. However, they may follow 
governmental unit boundaries and other invisible features in some instances; the 
boundary of a state or county is always a census tract boundary. Florida has 
3,154 tracts. 

Unincorporated Area 

Any geographic area that is not included in an incorporated place. 
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